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Finding Words

You can use the Find command to find a complete word or part of a word in the current PDF document.  Acrobat Reader looks for the word by reading every word on every page in the file, including text in form fields.

To find a word using the Find command:

1. Click the Find button (Binoculars), or choose Edit > Find.

2. Enter the text to find in the text box.

3. Select search options if necessary:

Match Whole Word Only finds only occurrences of the complete word you enter in the box.  For example, if you search for the word stick, the words tick and sticky will not be highlighted.

Match Case finds only words that contain exactly the same capitalization you enter in the box.

Find Backwards starts the search from the current page and goes backwards through the document.

4. Click Find.  Acrobat Reader finds the next occurrence of the word.

To find the next occurrence of the word, Do one of the following:

            Choose Edit > Find Again 

            Reopen the find dialog box, and click Find Again. 
            (The word must already be in the Find text box.)

Copying and pasting text and graphics to another application

You can select text or a graphic in a PDF document, copy it to the Clipboard, and paste it into another application such as a word processor.  You can also paste text into a PDF document note or into a bookmark.  Once the selected text or graphic is on the Clipboard, you can switch to another application and paste it into another document.  

Note:  If a font copied from a PDF document is not available on the system displaying the copied text, the font cannot be preserved.  A default font  is substituted.

To select and copy it to the clipboard:

1. Select the text tool T, and do one of the following:

       To select a line of text, select the first letter of the sentence or phrase and drag to
       the last letter.  

To select multiple columns of text (horizontally), hold down Ctrl+Alt (Windows) or Option (Mac OS) as you drag across the width of the document. 

To select a column of text (vertically), Hold down Ctrl+Alt (Windows) or Option+Command (Mac OS) as you drag the length of the document.

To  select all the text on the page, choose Edit > Select All.  In single page mode, all the text on the current page is selected.  In Continuous or Continuous – facing mode, most of the text in the document is selected.  When you release the mouse button, the selected text is highlighted.  To deselect the text and start over, click anywhere outside the selected text.  

The Select All command will not select all the text in the document.  A workaround for this (Windows) is to use the Edit > Copy command.  Choose Edit > Copy to copy the selected text to the clipboard.

2. To view the text, choose Window > Show Clipboard

In Windows 95, the Clipboard Viewer is not installed by default and you cannot use the Show Clipboard command until it is installed.  To install the Clipboard Viewer, Choose Start > Settings > Control Panel > Add/Remove Programs, and then click the Windows Setup tab.  Double-click Accessories, check Clipboard Viewer, and click OK.

[REPORT OF ACTION TAKEN IN CLOSED SESSION READ-IN

BY ACTING ASSISTANT EXECUTIVE OFFICER ON PAGE 32]
SUP. ANTONOVICH, MAYOR: THE SEPTEMBER 8, 2015 MEETING OF THE LOS ANGELES COUNTY BOARD OF SUPERVISORS WILL BEGIN. WE'RE GOING TO HAVE OUR INVOCATION BY SUPERVISOR DON KNABE AND OUR PLEDGE OF ALLEGIANCE BY SARAH SERRANO, WHO SERVED IN THE UNITED STATES MARINE CORPS AND FORMER SERGEANT. IF THE AUDIENCE WOULD PLEASE RISE. AND SUPERVISOR KNABE. 

SUP. KNABE: THANK YOU, MR. MAYOR, MEMBERS OF THE BOARD, LADIES AND GENTLEMEN, JUST JOIN ME IN AN ATTITUDE OF PRAYER, PLEASE. OH MOST KIND AND GRACIOUS HEAVENLY FATHER, WE COME BEFORE YOU THIS DAY TO GIVE YOU THANKS AS WE HAVE JUST CELEBRATED THE lABOR DAY AND THE MEN AND WOMEN THROUGHOUT OUR ENTIRE COUNTRY AND THE LABOR THAT THEY SERVE ON BEHALF OF OUR GREAT COUNTRY. AND, LORD, WE JUST ASK FOR YOUR CONTINUED GUIDANCE AND DIRECTION AND BLESSINGS ON THIS COUNTY THE WORK THAT WE DO HERE, THE MEN AND WOMEN OF OUR L.A. COUNTY FAMILY, THE MEN AND WOMEN OF LAW ENFORCEMENT, OUR FIRST RESPONDERS, ALL THAT THEY DO EACH AND EVERY DAY ON BEHALF OF THE 10 MILLION CITIZENS OF THIS GREAT COUNTY. WE JUST WANT TO THANK YOU FOR YESTERDAY. WE WANT TO THANK YOU FOR TODAY AND WE ASK FOR YOUR BLESSING TOMORROW. SO GUIDE AND DIRECT US. WATCH OVER US. GIVE US GOOD GUIDANCE, LORD. WE WANT TO THANK YOU FOR EVERYTHING THAT YOU DO ON BEHALF OF ALL OF US. AND ALL GOD'S PEOPLE SAID AMEN. 

SARAH SERRANO: PLEASE PLACE YOUR RIGHT HAND OVER YOUR HEARTS. IF YOU ARE A VETERAN YOU CAN RENDER A HAND SALUTE AS YOU JOIN ME IN THE PLEDGE OF ALLEGIANCE. [PLEDGE OF ALLEGIANCE RECITED.] 

SUP. SHEILA KUEHL: NORMALLY WE WOULD PRESENT A CERTIFICATE TO THE PERSON WHO LED US IN PRAYER, BUT REVEREND KNABE HAS ALREADY BEEN WELL HONORED, I THINK. SO LET ME RECOVER THE OTHER CERTIFICATE. TODAY WE WERE FORTUNATE TO BE LED IN THE PLEDGE OF ALLEGIANCE BY SARAH SERRANO WHO LIVES IN NORTH HOLLYWOOD, WHICH WE'RE VERY HAPPY TO SAY IS IN THE THIRD DISTRICT. SHE SERVED IN THE UNITED STATES MARINE CORPS FROM 2005 TO 2009. SHE ATTAINED A RANK OF SERGEANT E-5 WITH HER LAST ASSIGNMENT IN THE MARINE AVIATION WEAPONS AND TACTICS SQUADRON 1. HER DECORATIONS INCLUDE NAVY AND MARINE CORPS ACHIEVEMENT AND COMMENDATION MEDALS, GOOD CONDUCT MEDAL AND TWO GLOBAL WAR ON TERRORISM MEDALS. SHE'S A GRADUATE OF LAGUNA BEACH HIGH SCHOOL. CURRENTLY ATTENDS LOS ANGELES VALLEY COLLEGE. HOPES TO TRANSFER TO U.S.C. NEXT FALL. AS A BRUIN, I WILL PRETEND I DIDN'T SEE THAT. IN ADDITION SHE SERVES AS GENERAL MANAGER FOR THE NONPROFIT VETERANS IN FILM AND TELEVISION WHERE SHE WORKS TO HELP PLACE HUNDREDS OF VETERANS IN ENTERTAINMENT INDUSTRY POSITIONS WHERE THEY CAN RECEIVE EDUCATION, TRAINING AND EMPLOYMENT OPPORTUNITIES. PLEASE HELP ME TO THANK SARAH SERRANO. [APPLAUSE.] 

AVIANNA URIBE, ACTING ASS'T. EXEC. OFCR: GOOD AFTERNOON, MR. MAYOR AND MEMBERS OF THE BOARD. TODAY'S AGENDA WILL BEGIN ON PAGE 4, SPECIAL DISTRICTS AGENDA, AGENDA FOR THE MEETING OF THE COMMUNITY DEVELOPMENT COMMISSION, ITEM 1-D. 

SUP. ANTONOVICH, MAYOR: MOTION BY SUPERVISOR SHEILA KUEHL. SECOND WITHOUT OBJECTION, SO ORDERED. 

AVIANNA URIBE, ACTING ASS'T. EXEC. OFCR: ON PAGE 5, AGENDA FOR THE MEETING OF THE HOUSING AUTHORITY, ITEM 1-H. 

SUP. ANTONOVICH, MAYOR: MOTION BY SUPERVISOR DON KNABE. SECOND WITHOUT OBJECTION, SO ORDERED. 

AVIANNA URIBE, ACTING ASS'T. EXEC. OFCR: ON PAGE 6, AGENDA FOR THE MEETING OF THE REGIONAL PARK AND OPEN SPACE DISTRICT. ITEM 1-P AND ITEM 2-P. I HAVE MEMBERS OF THE PUBLIC THAT WOULD LIKE TO HOLD THIS ITEM. ON PAGE 7, BOARD OF SUPERVISORS, ITEMS NO. 1 THROUGH 8. ON ITEM NO. 1 AND 2 I HAVE MEMBERS OF THE PUBLIC THAT REQUEST THAT THIS ITEM BE HELD. ON ITEM NO. 3 AND ITEM NO. 5, MEMBERS OF THE PUBLIC REQUEST THAT THIS ITEM BE HELD. ON ITEM NO. 8, SUPERVISOR KNABE REQUESTS THAT THIS ITEM BE CONTINUED ONE WEEK TO SEPTEMBER 15, 2015. ON ITEM NO. 9, SUPERVISOR KNABE AND SUPERVISOR KUEHL REQUEST THIS ITEM BE CONTINUED ONE WEEK TO SEPTEMBER 15, 2015. ON ITEM NO. 10, SUPERVISOR KNABE REQUESTS THAT THIS ITEM BE CONTINUED ONE WEEK TO SEPTEMBER 15. ON ITEM 13 AND ITEM 15 AND ITEM 18, A MEMBER OR MEMBERS OF THE PUBLIC REQUEST THAT THIS ITEM BE HELD. THE REMAINING ITEMS UNDER THE BOARD OF SUPERVISORS' AGENDA IS BEFORE YOU. 

SUP. ANTONOVICH, MAYOR: MOTION BY SUPERVISOR HILDA SOLIS. SECOND WITHOUT OBJECTION, SO ORDERED. 

AVIANNA URIBE, ACTING ASS'T. EXEC. OFCR: ON PAGE 15, CONSENT CALENDAR ITEMS 19 THROUGH 38. ON ITEM 19, A MEMBER OF THE PUBLIC REQUESTS THAT THIS ITEM BE HELD. ON ITEM NO. 20, SUPERVISOR KUEHL REQUESTS THAT THIS ITEM BE CONTINUED ONE WEEK TO SEPTEMBER 15, 2015. ON ITEM 21, A MEMBER OF THE PUBLIC REQUESTS THAT THIS ITEM BE HELD. ON ITEM 22, A MEMBER OF THE PUBLIC REQUEST THAT THIS ITEM BE HELD. ON ITEM 23, THE DIRECTOR OF HEALTH SERVICES REQUESTS THAT THIS ITEM BE CONTINUED ONE WEEK TO SEPTEMBER 15, 2015. ON ITEM 24 AND 25, A MEMBER OR MEMBERS OF THE PUBLIC REQUEST THAT THIS ITEM BE HELD. ON ITEM NO. 26, SUPERVISOR KUEHL REQUEST THAT THIS ITEM BE CONTINUED ONE WEEK TO SEPTEMBER 1ST-- I'M SORRY SEPTEMBER 15, 2015. ON ITEM 28, SUPERVISOR RIDLEY-THOMAS REQUESTS THAT THIS ITEM BE CONTINUED ONE WEEK TO SEPTEMBER 15, 2015. ON ITEM NO. 29, A MEMBER OF THE PUBLIC REQUESTS THAT THIS ITEM BE HELD. ON ITEM NO. 30, THE DIRECTOR OF PARKS AND RECREATION REQUESTS THAT THIS ITEM BE REFERRED BACK TO THE DEPARTMENT. ON ITEM 31, THE DIRECTOR OF PUBLIC WORKS REQUESTS THAT THIS ITEM BE CONTINUED ONE WEEK TO SEPTEMBER 15, 2015. ON ITEM 36, A MEMBER OF THE PUBLIC REQUESTS THAT THIS ITEM BE HELD. THE REMAINING ITEMS UNDER THE CONSENT CALENDAR ARE BEFORE YOU. 

SUP. ANTONOVICH, MAYOR: MOTION BY SUPERVISOR SHEILA KUEHL. SECOND WITHOUT OBJECTION, SO ORDERED. 

AVIANNA URIBE, ACTING ASS'T. EXEC. OFCR: ON PAGE 25, ORDINANCES FOR INTRODUCTION. ITEMS 39. 

SUP. KNABE: I WANT TO WITHDRAW MY CONTINUANCE OF ITEM NUMBER 8. I'LL DEAL WITH IT TODAY. 

AVIANNA URIBE, ACTING ASS'T. EXEC. OFCR: OKAY. ITEM NO. 8 IS BEFORE YOU. 

SUP. ANTONOVICH, MAYOR: MOTION BY SUPERVISOR KNABE. SECOND BY SUPERVISOR KUEHL. WITHOUT OBJECTION, SO ORDERED ON ITEM 8. 

AVIANNA URIBE, ACTING ASS'T. EXEC. OFCR: ON PAGE 25, ORDINANCES FOR INTRODUCTION, ITEMS 39 THROUGH 41. ON ITEM 39 THIS IS AN ORDINANCE FOR INTRODUCTION AMENDING COUNTY CODE, TITLE 4, REVENUE AND FINANCE TO ALLOW FOR REWARD OFFERS TO BE MADE IN EXCHANGE FOR INFORMATION LEADING TO, LOCATING, AND/OR APPREHENDING SEX OFFENDERS WHO ABSCOND WHILE ON ACTIVE PAROLE PROBATION. 

SUP. ANTONOVICH, MAYOR: SO MOVED BY SUPERVISOR KUEHL. WITHOUT OBJECTION, SO ORDERED. 

AVIANNA URIBE, ACTING ASS'T. EXEC. OFCR: ON ITEM 40, MOTION BY SUPERVISOR KUEHL THAT IT CONTINUED ONE WEEK TO SEPTEMBER 15, 2015. 

SUP. ANTONOVICH, MAYOR: I'LL SECOND THAT WITHOUT OBJECTION SO ORDERED. 

AVIANNA URIBE, ACTING ASS'T. EXEC. OFCR: ON ITEM 41, THIS IS AN ORDINANCE FOR INTRODUCTION AMMENDING COUNTY CODE TITLE SIX SALARIES, BY CHANGING, ADDING OR DELETING CERTAIN CLASSIFICATIONS AND NUMBERS OF ORDINANCE POSITIONS IN THE DEPARTMENTS. ON THIS ITEM A MEMBER OF THE PUBLIC REQUESTS THAT THIS ITEM BE HELD. ON PAGE 26, SEPARATE MATTER, ITEM 42, ON ITEM 42, APPROVE THE ISSUANCE OF SHORT-TERM BOND ANTICIPATION NOTES IN AN AGGREGATE AMOUNT NOT TO EXCEED $46,000,500,000 TO FINANCE THE ACQUISITION OF VARIOUS EQUIPMENT NEEDS THROUGH LOS ANGELES COUNTY CAPITAL ASSET LEASING CORPORATION ON ON THIS ITEM, A MEMBER OF THE PUBLIC REQUESTS THAT THIS ITEM BE HELD. ON PAGE 27, MISCELLANEOUS ADDITIONS TO THE AGENDA WHICH WERE POSTED MORE THAN 72 HOURS IN ADVANCE OF THE MEETING AS INDICATED ON THE SUPPLEMENTAL AGENDA. ITEM 43-A. 

SUP. ANTONOVICH, MAYOR: I'LL MOVE, SECOND BY SUPERVISOR SOLIS. WITHOUT OBJECTION, SO ORDERERT. 

AVIANNA URIBE, ACTING ASS'T. EXEC. OFCR: ITEM 43-B. 

SUP. ANTONOVICH, MAYOR: I'LL MOVE. SECOND BY SUPERVISOR KNABE. WITHOUT OBJECTION, SO ORDERED. 

AVIANNA URIBE, ACTING ASS'T. EXEC. OFCR: ON ITEM 43-C. SUPERVISOR ANTONOVICH REQUESTS THAT THIS ITEM BE HELD. THAT COMPLETES THE READING OF THE AGENDA. BOARD OF SUPERVISORS SPECIAL ITEMS BEGINS WITH SUPERVISORIAL DISTRICT NO. 2. 

SUP. ANTONOVICH, MAYOR: IT'S A REAL PLEASURE TO WELCOME THE NEW CONSUL GENERAL OF QATAR HERE. WE WERE JUST MENTIONING THREE YEARS AGO THE KING AND HIS WIFE WERE HERE. A FRIEND OF MINE, AMBASSADOR CHASE UNTERMEYER WAS THE AMBASSADOR TO QATAR AS WELL. WHAT WAS INTERESTING IS THE PLURALITY THAT THEY HAVE IN QATAR THE KING WAS VERY PLEASED THEY WERE BUILDING A CATHOLIC CHURCH. THE QUEEN WAS VERY PLEASED THAT THE WOMEN DRIVE. IT WAS A VERY GOOD -- IT WAS MORE THAN THREE YEARS AGO, BUT, ANYWAY, IT WAS A GREAT VISIT. BUT TODAY WE WILL WELCOME THE NEW CONSUL GENERAL. THAT'S KHALID Y. AL-SADA WHO IS REPRESENTING HIS COUNTRY HERE. HE IS A CAREER DIPLOMAT AND BEFORE HE JOINED THE MINISTRY OF FOREIGN AFFAIRS, HE EARNED A BACHELOR'S DEGREE IN ENGINEERING IN THE UNITED KINGDOM WITH A FOCUS ON INFORMATION TECHNOLOGY. HE ALSO EARNED AGREE A DIPLOMA IN FOREIGN POLICY STUDIES AT GEORGETOWN UNIVERSITY. HE BEGAN HIS CAREER IN THE MINISTRY OF FOREIGN AFFAIRS AS ASSISTANT DIRECTOR IN THE DEPARTMENT OF INFORMATION SYSTEMS TECHNOLOGY WHERE HE OVERSAW THE DEVELOPMENT OF DATA AND INFORMATION SYSTEMS FOR ADMINISTRATIVE UNITS IN THE MINISTRY AND DIPLOMATIC MISSIONS ABROAD. HE THEN SERVED AS A MEMBER OF THE MINISTRY COMMITTEE THAT MONITORED RELATIONS WITH THE UNITED NATIONS AND ADVISED OTHER MINISTRIES ON PARTICIPATION IN INTERNATIONAL ORGANIZATIONS, CONFERENCES AND MEETINGS. CONSUL GENERAL WAS APPOINTED DEPUTY HEAD OF MISSIONS AT THE EMBASSY IN JAPAN. DURING HIS STAY, HE WAS A MEMBER OF THE QATAR FRIENDSHIP FUND, WHICH PROVIDED AID TO THE JAPANESE COMMUNITIES THAT WERE DEVASTATED BY THE 2011 EARTHQUAKE AND TSUNAMI. FROM THERE HE CAME TO LOS ANGELES COUNTY, AND SO OUR BOARD WANTS TO WELCOME HIM HERE AND GIVE HIM THIS PRESENTATION. THEN HE CAN SAY A COUPLE WORDS. 

KHALID Y. AL-SADA, CONSUL GENERAL OF QATAR: HONORABLE MEMBERS OF THE BOARD OF SUPERVISORS OF LOS ANGELES COUNTY, LADIES AND GENTLEMEN, MY NAME IS KHALID AL-SDA AND I AM CONSUL GENERAL FOR THE STATE OF QATAR IN LOS ANGELES. I BEGIN MY EXPRESS MY SINCERE GRATITUDE TO YOU FOR AFFORDING ME THE OPPORTUNITY TO SHARE A FEW THOUGHTS DURING YOUR OFFICIAL BOARD MEETING. SO THANK YOU VERY MUCH FOR GIVING ME YOUR TIME. I'LL ALSO THANK MS. LOURDES SAAB FOR ORGANIZING THIS VISIT. SHE HAS BEEN A DEAR FRIEND AND A STEADY FOUNT OF SUPPORT EVER SINCE WE OPENED OUR CONSULATE DOORS TWO YEARS AGO. I ALSO CONGRATULATE LOS ANGELES ON A SUPERB JOB IN HOSTING THE SPECIAL OLYMPICS EARLIER THIS SUMMER. IT WARMED MY HEAT TO SEE QATARI ATHLETES AND THEIR PEERS FROM ACROSS THE GLOBE COMPETE IN A FRIENDLY ATMOSPHERE OF FUN. HONORABLE MEMBERS OF BOARD OF SUPERVISORS, BEFORE I ARRIVED TO LOS ANGELES, I SERVED AS THE DEPUTY HEAD OF MISSION AT QATAR EMBASSY IN TOKYO, JAPAN. DURING MY MISSION IN TOKYO, I HELPED GROW ECONOMIC AND CULTURAL TIES BETWEEN QATAR AND JAPAN. TODAY JAPAN AND QATAR ARE THE BIGGEST TRADE PARTNERS. IN MY CURRENT ROLE AS A CONSUL GENERAL OF QATAR OF LOS ANGELES, I'M JUST AS COMMITTED TO GROW ECONOMIC TIES BETWEEN LOS ANGELES AND QATAR. IN 2014, CALIFORNIA RANKED THIRD IN THE UNITED STATES IN TOTAL TRADE WITH THE G.C.C. WITH QATAR AMONG THE TOP THREE EXPORT DESTINATIONS. IN FACT, EXPORT FROM CALIFORNIA TO QATAR IN 2014 GREW TO APPROXIMATELY $600 MILLION. SECOND ONLY TO WASHINGTON STATE WITH THE MOST EXPORTS ORGANIZING FROM THE LOS ANGELES PORT. ONE OF MY KEY PRIORITIES IS TO DISCUSS WITH YOU HOW TO FURTHER GROW TRADE AND INVESTMENT BETWEEN QATAR AND LOS ANGELES. HONORABLE MEMBERS OF BOARD OF SUPERVISORS, IN ADDITION TO ECONOMIC DEVELOPMENT, THE STATE OF QATAR HAS ALSO PLACED A HIGH EMPHASIS ON SOCIAL EDUCATION AND CULTURAL DEVELOPMENT. QATAR FOUNDATION CONTINUES TO LEAD HUMAN, SOCIAL AND ECONOMIC DEVELOPMENT FOR THE PROTECTIVE CHANGE IN QATAR. ALSO, THE NEIGHBOR REGION AND THE BROADER INTERNATIONAL COMMUNITY. QATAR SCIENCE AND TECHNOLOGY PARK IS OUR PRIMARY INCUBATOR FOR TECHNOLOGY DEVELOPMENT AND CONTINUES TO ACCELERATE THE COMMERCIALIZATION OF THE RESEARCH AND SUPPORT INNOVATION. HONORABLE MEMBERS OF BOARD OF SUPERVISORS, THE STATE OF QATAR HAS ALREADY DEMONSTRATED THROUGH VARIOUS EXAMPLES THAT LOS ANGELES IS INDEED A STRATEGIC PARTNER. IN JANUARY 2015, QATAR AIRWAYS WILL COMMENCE DAILY NONSTOP FLIGHTS BETWEEN DOHA AND LOS ANGELES. ALSO THE DOHA GOALS FORUM AS A GLOBAL MEETING AND SPORT AND DEVELOPMENT WAS HELD FOR THE FIRST TIME OUTSIDE OF QATAR THIS SUMMER IN LOS ANGELES. THIS MONTH, THE QATAR INVESTMENT AUTHORITY WILL OPEN AN OFFICE IN THE UNITED STATES ONLY IT'S THE THIRD OFFICE OUTSIDE OF QATAR AND WILL INVEST ABOUT $30 BILLION IN THE UNITED STATES OVER FIVE-YEAR PERIOD, WITH CALIFORNIA AMONG THE STRATEGIC INVESTMENT MARKETS. THERE ARE ROUGHLY 7,000 QATARI STUDENTS STUDYING IN THE U.S., WITH MANY IN THE COMMUNITY COLLEGES AND UNIVERSITIES OF LOS ANGELES COUNTY. FINALLY, THE GREATER LOS ANGELES CONTINUES TO BE THE TOP TOURIST DESTINATION FOR OUR NATIONALS. ON BEHALF OF STATE OF QATAR, I SEND A CLEAR MESSAGE TO YOU AND THE WONDERFUL PEOPLE OF LOS ANGELES COUNTY. MY OFFICE DOORS ARE ALWAYS OPEN TO YOU AS I'M HERE TO GET TO KNOW YOU AND TO DISCUSS HOW WE COULD PROMOTE GREATER TIES BETWEEN OUR PEOPLE. THANK YOU SO MUCH. THANK YOU. [APPLAUSE.] 

SUP. ANTONOVICH, MAYOR: SUPERVISOR KNABE? 

SUP. KNABE: THANK YOU, MR. MAYOR, IT'S MY PLEASURE TO CALL UP KEVIN WATTIER WHO IS THE GENERAL MANAGER OF THE LONG BEACH WATER DEPARTMENT. WITH HIM IS HIS WIFE JULIE AND ROB WHITTAKER WHO IS THE GENERAL MANAGER OF THE WATER REPLENISHMENT DISTRICT. KEVIN OVERSEES THE DAY-TO-DAY OPERATIONS AND BUSINESS ACTIVITY OF ONE OF THE MOST RELIABLE AND ADVANCED MUNICIPAL WATER RETAIL AGENCIES IN THE COUNTRY. HE AND HIS TEAM REGULATE THE SALE, USE AND DISTRIBUTION OF WATER IN THE CITY OF LONG BEACH. THE DEPARTMENT OPERATES ONE OF THE LARGEST GROUND WATER TREATMENT FACILITIES IN THE ENTIRE UNITED STATES. BEFORE JOINING THE LONG BEACH WATER DEPARTMENT, HE WAS A PRINCIPAL AT MCGUIRE ENVIRONMENTAL CONSULTANTS WHERE HE SERVED AS EXECUTIVE DIRECTOR OF THE CALIFORNIA URBAN WATER AGENCIES IN SACRAMENTO, HE SPENT 13 YEARS WITH THE METROPOLITAN WATER DISTRICT AND MANY VARIOUS POSITIONS. HIS LAST WAS THE ASSISTANT CHIEF OF OPERATION. HE IS A REGISTERED PROFESSIONAL ENGINEER IN THE STATE OF CALIFORNIA, THE CALIFORNIA DEPARTMENT OF HEALTH SERVICES HAS CERTIFIED HIM AS A GRADE 5 WATER TREATMENT OPERATOR. HE RECEIVED HIS B.S. IN ENGINEERING FROM SOUTH DAKOTA STATE UNIVERSITY AND AN M.S. IN ENVIRONMENTAL ENGINEERING FROM CLARKSON UNIVERSITY. HE WILL RETIRE AS THE GENERAL MANAGER OF THE LONG BEACH WATER DEPARTMENT THIS WE CAN ON SEPTEMBER 11TH. SO ON BEHALF OF THE BOARD, WE WANT TO COMMEND HIM AND THANK HIM FOR HIS 40 YEARS IN THE INDUSTRY AND 14 YEARS WITH THE GREAT CITY OF LONG BEACH AND WISH HE AND JULIE A MOST HAPPY AND WONDERFUL RETIREMENT AND MOST IMPORTANTLY A HEALTHY ONE. SO, KEVIN, CONGRATULATIONS. [APPLAUSE.] 

KEVIN WATTIER: WELL, THANK YOU, SUPERVISOR KNABE FOR YOUR SUPPORT AND FRIENDSHIP OVER THE YEARS. BECAUSE OF YOUR LEADERSHIP, WE'VE ACCOMPLISHED A LOT AND THERE'S A LOT MORE TO ACCOMPLISH. I WANT TO THANK THE ENTIRE BOARD OF SUPERVISORS FOR THIS HONOR TODAY. MOST IMPORTANTLY I WANT TO RECOGNIZE MY FRIEND RALPH WHITTAKER AND MY WIFE JULIE LEE. JULIE STARTED WITH THE COUNTY. HER FIRST JOB WAS WITH PUBLIC WORKS. IT'S NICE SHE COULD BE HERE TODAY. THANK YOU VERY MUCH. IT'S VERY THOUGHTFUL. [APPLAUSE.] 

SUP. ANTONOVICH, MAYOR: TODAY IS GOING TO BE THE NATIONAL DAY OF SERVICE AND REMEMBRANCE. WITH US IS GENERAL RUTH WONG WHO IS THE DIRECTOR OF THE COUNTY DEPARTMENT OF MILITARY VETERANS' AFFAIRS TO MARK THIS 14TH ANNIVERSARY OF THE TRAGIC EVENTS OF SEPTEMBER 11, 2001 AND REMEMBER ALL THOSE WHO LOST THEIR LIVES. THE EVENT WILL ALWAYS BE A PART OF OUR HISTORY, THE DAY ALL AMERICANS AND OTHERS UNITED AND UNSELFISHLY DEMONSTRATED IN THE AFTERMATH OF THIS HORRIFIC TERRORIST ATTACK BY SUPPORTING CHARITABLE CAUSES, PERFORMING GOOD DEEDS AND ENGAGING IN OTHER SERVICE ACTIVITIES. TO HONOR THOSE VICTIMS OF 9/11 THE BOARD URGES ALL COUNTY RESIDENTS TO PARTICIPATE IN THE NATIONAL DAY OF SERVICE, A REMEMBRANCE BY VOLUNTEERING WITH A LOCAL CHARITY OF THEIR CHOICE. I WAS IN WASHINGTON, D.C. ON 9/11 AND REMEMBER THE IMPACT IT HAD WHERE OUR NATION WAS UNDER MARSHAL LAW FOR A PERIOD OF TIME. AND EVERYTHING WAS CHAOTIC AND WE WERE LIKE THOSE WATCHING -- I SHOULD SAY THOSE PARTICIPANTS THAT WE OBSERVED, THOSE REFUGEES FLEEING AND RUNNING AND TRYING TO FIND ORDER OCCURRING ON OUR CAPITAL STREETS, NOT RECOGNIZING THAT THIS WAS IN THE UNITED STATES OF AMERICA NOT ON C.N.N. OR FOX NEWS OR ONE OF THE OTHER TELEVISION STATIONS. SO LET ME GIVE THIS TO YOU, GENERAL, AND THANK YOU FOR YOUR LEADERSHIP. [APPLAUSE.] 

GEN. RUTH WONG:: THANK YOU, BOARD OF SUPERVISORS, FOR PRESENTING THE SCROLL TO OUR DEPARTMENT OF MILITARY AND VETERANS' AFFAIRS. OUT OF THIS TRAGEDY 9/11. MILLIONS OF YOUNG AMERICANS TOOK THE OATH OF OFFICE TO DEFEND OUR COUNTRY'S FREEDOM BY JOINING THE MILITARY. THEIR SERVICE AND SACRIFICE HONORS THE MEMORY OF THOSE THAT WE LOST IN 9/11 AND HELPS US AS A NATION TO MOVE FORWARD AND WORK TOGETHER TO STRENGTHEN OUR COMMUNITIES ACROSS THE NATION AND PARTICULARLY IN OUR COUNTY OF LOS ANGELES. THANK YOU TO THE MEN AND WOMEN THAT ARE SERVING OUR COUNTRY TODAY FIGHTING THE WAR ON GLOBAL TERRORISM. [APPLAUSE.] 

SUP. ANTONOVICH, MAYOR: NOW WE HAVE WITH US THE PRESIDENT OF NATIONAL ASSOCIATION OF INSURANCE AND FINANCIAL ADVISORS AND MEMBERS THERESA DEMENNING AND NICHOLAS PEREZ AS WE RECOGNIZE THE NATIONAL ASSOCIATION OF INSURANCE AND FINANCIAL ADVISORS OF CALIFORNIA COMMEMORATING LIFE INSURANCE AWARENESS MONTH IN OUR COUNTY. MOST AMERICANS RECOGNIZE THE SIGNIFICANCE OF OWNING INSURANCE TO SAFEGUARD THEIR FINANCIAL AND WELL-BEING OF THEIR LOVED ONES. DESPITE THE PEACE OF MIND THAT LIFE INSURANCE BRINGS TO MILLIONS OF AMERICAN FAMILIES, THERE ARE STILL MILLIONS THAT LACK ADEQUATE LIFE INSURANCE COVERAGE. A RECENT SURVEY FOUND THAT NEARLY HALF OF ALL AMERICANS ARE WORRIED ABOUT HOW THEIR FAMILIES WOULD MANAGE FINANCIALLY IF THEY WERE TO DIE TOMORROW. THE GOAL OF LIFE INSURANCE AWARENESS MONTH IS TO PROVIDE CONSUMERS INFORMATION ON THEIR NEED FOR LIFE INSURANCE PROTECTION TO ENCOURAGE ONE TO SEEK ADVICE FROM A QUALIFIED INSURANCE PROFESSIONAL AND TO TAKE THE ACTIONS NECESSARY TO ACHIEVE FINANCIALLY SECURE FUTURE FOR THEIR LOVED ONES. 

NICHOLAS PEREZ: THANK YOU, SUPERVISOR. IT IS A PLEASURE ADDRESSING THE ESTEEMED BOARD MEMBERS OF THE L.A. COUNTY BOARD OF SUPERVISORS. AND AS A SON OF A CALIFORNIA, MY FAMILY ROOTING THEMSELVES HERE IN SAN GABRIEL IN 1748, WE'VE BEEN HERE SINCE, IT'S MY PLEASURE TO ADDRESS YOU FOLKS ON SOME OF THE KEY POINTS ON WHY WE IN THE FINANCIAL SERVICES INDUSTRY FEEL LIFE INSURANCE AWARENESS MONTH IS SO IMPORTANT. WHEN WE TALK ABOUT EDUCATING FOLKS ON WHAT YOU CAN DO FOR YOUR OWN SECURITY, THE TOOLS YOU HAVE ACCESS TO, WHEN WE EDUCATE THE PUBLIC AND BUSINESS OWNERS, ESPECIALLY SMALL BUSINESS OWNERS ON THERE'S WAYS TO PROTECT YOUR BUSINESS, TO BE ABLE TO PROTECT YOUR RETIREMENT IN A MANNER THAT IS CUSTOMIZED AND TAILORED TO YOUR OWN SPECIFIC SITUATION. THAT'S WHAT'S HERE. MY KEY POINTS THAT I LOVE WITH SEPTEMBER AND BEING LIFE INSURANCE AWARENESS MONTH: IT'S NOT JUST BECAUSE IT'S MY BIRTHDAY IN THIS MONTH, BUT IT'S IMPORTANT FOR YOU TO UNDERSTAND WHAT THESE MYTHS ARE ABOUT LIFE INSURANCE, THE FACT THAT I'M SUPER YOUNG, I DON'T NEED TO WORRY ABOUT IT. IT'S INCORRECT. WHEN YOU'RE ABLE TO LOCK IN YOUR HEALTH AND PROTECT YOUR FUTURE FROM A MEDICAL SITUATION, POSSIBLY NOT QUALIFYING WHEN YOU'RE OLDER, IT'S A GREAT IDEA TO GET IT WHEN YOU'RE YOUNGER. THE MYTH ABOUT THERE'S NO WAY TO GET IT BECAUSE IT'S SUPER EXPENSIVE. YOU WANT TO TALK ABOUT EXPENSIVE COMPARED TO WHAT? IS IT MORE EXPENSIVE THAN HAVING TO HAVE SIGNS OUT FOR A CAR WASH TO BE ABLE TO PAY FOR A CHILD'S FUNERAL? IS IT MORE EXPENSIVE THAN NOT HAVING THE MONEY THAT YOU NEED FOR YOUR FAMILY WHEN YOU HAVE BUILT A LEGACY AND THERE'S NO LEGACY MONEY TO TAKE CARE OF THE NEXT GENERATION? ABSOLUTELY NOT. WE EDUCATE ON THESE MAIN POINTS HERE. WHEN FOLKS GO THROUGH THE CONCEPT OF "I'M OVER 65. HOW DO I AFFORD IT OR ARE THERE EVEN PRODUCTS FOR ME?" OF COURSE THERE ARE. THERE'S A LOT OF DIFFERENT WAYS WE CAN TAILOR TO YOUR NEEDS. WE LOOK AT YOUR INCOME, WE LOOK AT YOUR HEALTH, WE LOOK AT THE AVAILABILITY OF WHAT YOU HAVE ACCESS TO TO MAKE SURE THAT WE'RE GOING TO CREATE A LONG LASTING LEGACY FOR YOU AND YOUR FAMILY SHOULD YOU CHOOSE TO. WE TALK ABOUT THERE'S NO REASON I NEED TO GET PERMANENT INSURANCE. WELL, WE TALK ABOUT THE "WHY." NO THERE'S NO ONE-SIZE-FITS-ALL. LIFE INSURANCE IS SOMETHING THAT WILL BE TAILORED TO YOUR SITUATION MEANING THERE MIGHT BE A REASON TO HAVE A PERMANENT POLICY. THERE IS A REASON TO HAVE TAX-FREE INCOME IN YOUR RETIREMENT. THERE'S A REASON TO BE ABLE TO CONTROL YOUR TAX BRACKET IN RETIREMENT. THESE TOOLS ARE PARTLY BASED IN LIFE INSURANCE. THERE ARE LOTS OF WAYS YOU CAN GET EDUCATED. THERE ARE THOUSANDS OF QUALITY AGENTS AND AMAZING COMPANIES THAT ARE HERE TO EDUCATE YOU. TAKE THE TIME. MAKE SURE YOU'RE ABLE TO UNDERSTAND YOUR WHY BEHIND IT. AND IF YOU HAVE ANY QUESTIONS, OUR TEAM AND OUR STAFF ARE ALWAYS HERE FOR YOU. THANK YOU VERY MUCH. [APPLAUSE.] 

SUP. ANTONOVICH, MAYOR: THIS IS TWO OF OUR WONDERFUL, BEAUTIFUL LITTLE PUPPIES. BUTTERCUP AND SARAH. THIS IS SARAH. THIS IS BUTTERCUP. THEY'RE LOOKING FOR A HOME. AND THOSE WHO WOULD LIKE TO ADOPT ONE OR BOTH CAN CALL 562-728-4610. THEY ARE EIGHT WEEKS OLD. AND THEY WILL PROVIDE A LOT OF WONDERFUL MEMORIES. WHAT DO YOU THINK? HMM? LOOK AT THE MAN WITH A CAMERA. THE MAN WITH A CAMERA WILL HELP YOU GET A HOME. MAYBE SHEILA WILL TAKE YOU HOME IN THAT LITTLE RED SPORTS CAR. SHE'D LOVE TO RIDE THAT LITTLE SPORTS CAR. THEY FIT. TWO LITTLE BUTTERCUPS. WE ARE GOING TO MOVE INTO EXECUTIVE SESSION ON AN IMPORTANT ISSUE. OH, YOU HAVE A MOTION? EXCUSE ME. SUPERVISOR HILDA SOLIS. PRESENTATION. OKAY. YEAH. 

SUP. HILDA SOLIS: THANK YOU, MR. MAYOR. I'M PRIVILEGED THIS AFTERNOON TO RECOGNIZE -- 

SUP. KNABE: YOUR MIC'S NOT ON. 

SUP. HILDA SOLIS: THANK YOU, MR. MAYOR. I'M DELIGHTED TO CALL FORWARD SOME OUTSTANDING INDIVIDUALS IN CELEBRATION OF LABOR DAY THAT MANY AMERICANS, MILLIONS OF AMERICANS SPENT YESTERDAY HONORING THE WORK ON BEHALF OF WORKING MEN AND WOMEN THROUGHOUT OUR COUNTRY. YOU KNOW OUR HISTORY TELLS US THAT BACK IN THE 19TH CENTURY, THIS DAY WAS CELEBRATED AS -- IT BECAME A FEDERAL HOLIDAY ACTUALLY IN 1894. BUT LONG BEFORE THAT, THERE WERE MANY PEOPLE WHO WORKED VERY, VERY HARD FOR THE RIGHTS THAT WE HAVE TODAY. IN FACT, SOME OF THEM DURING THE HEIGHT OF THE INDUSTRIAL REVOLUTION AT THAT TIME THE AVERAGE U.S. WORKER TOILED 12 HOURS A DAY 7 DAYS A WEEK JUST TO PUT FOOD ON THE TABLE. SOMETIMES WE FORGET THAT. CHILDREN AS YOUNG AS FIVE OR SIX ALSO WERE REQUIRED TO WORK IN FACTORIES. WE CALL THEM SWEAT SHOPS IN MANY WAYS. AND SOMETIMES IN THE FIELDS AND SOMETIMES IN COAL MINES ACROSS THE COUNTRY. THE VERY POOR AND RECENT IMMIGRANTS ALSO FACED UNSAFE WORKING CONDITIONS WITH INSUFFICIENT ACCESS TO FRESH AIR, SANITARY FACILITIES, AND EVEN BREAK PERIODS. THOUGH WE HAVE MADE PROGRESS IN MANY WAYS, WE STILL HAVE MUCH MORE TO DO. SO ON THE POST-HOLIDAY SEASON HERE I WANT TO RECOGNIZE SOME OUTSTANDING LEADERS THAT HAVE CONTRIBUTED TO THE WORK OF OUR COMMUNITIES IN A BIG WAY. AND I'M DELIGHTED TO RECOGNIZE THEM THIS AFTERNOON. WE HAD A VERY NICE LUNCHEON TO CELEBRATE LABOR DAY AND I WAS PLEASED AND HONORED THAT WE HAVE THE COOPERATION OF OUR STAFF, THE COUNTY FAMILY AND EVERYONE BECAUSE WE ARE ALL WORKERS. SO I WANT TO THANK THE COUNTY OF LOS ANGELES AND THE BOARD FOR GIVING ME THIS PRIVILEGE TO HONOR THESE INDIVIDUALS. THE FIRST INDIVIDUAL THAT I'D LIKE TO CALL UP, I'D LIKE TO CALL HER "HERMANA," WHICH IN SPANISH MEANS SISTER. BUT SHE'S SO MUCH MORE THAN THAT TO MANY OF US HERE IN THE COUNTRY AND IN LOS ANGELES COUNTY. I'D LIKE TO INVITE MY FRIEND UP, MISS MARIA ELENA DURAZO TO JOIN ME HERE BY MY SIDE. [APPLAUSE.] TODAY WE'RE HONORING MS. DURAZO FOR HER SERVICE AND LEADERSHIP IN THE FIGHT FOR LOCAL WORKERS LOCALLY AS ALL AS NATIONALLY AND INTERNATIONALLY. AS 1 OF 10 CHILDREN OF MEXICAN IMMIGRANT FARM WORKERS, SHE OFTEN HELPED HER PARENTS AS THEY WORKED AND TOILED IN THE FIELDS. IN 1983 SHE BEGAN HER WORK AS AN ORGANIZER WITH THE HOTEL EMPLOYEES AND RESTAURANT UNION KNOWN AS HERE, LOCAL 11. THAT'S WHEN I BELIEVE I MET HER. SHE CAMPAIGNED TO TRANSFORM LOCAL 11 IN LOS ANGELES AND SOUTHERN CALIFORNIA AND SUCCESSFULLY TURNED THE UNION INTO AN ACCOUNTABLE ORGANIZATION THAT ANSWERED TO ITS MEMBERSHIP WHEN IT WOULD FIGHT FOR WORKERS' RIGHTS AND PREVAILING WAGES. IT WAS DURING HER TIME HERE WHEN SHE CAMPAIGNED FOR HOUSEKEEPERS WHO WERE MAINLY IMMIGRANT LATINA WOMEN TO ORGANIZE AND DEMAND SAFER WORKING CONDITIONS, FAIR WAGES AND ACCESSIBILITY TO HEALTHCARE. SHE ALSO INSURED THAT ALL MEMBERS, INCLUDING HOUSEKEEPERS, BARTENDERS, WAITERS, BELL- HOPS AND HOTEL WORKERS IN THE BOOMING SOUTHERN CALIFORNIA HOTEL TOURISM INDUSTRY WOULD HAVE THE RIGHT TO COLLECTIVE BARGAINING IN ORDER TO ACHIEVE BETTER WORKING CONDITIONS AND WAGES. ALSO, MARIA ELENA HAS PLAYED A PIVOTAL ROLE TO ENSURE THAT THE HIRING AND TRAINING OF AFRICAN-AMERICANS WAS IMPLEMENTED IN THE HOTEL INDUSTRY. FURTHER, ON MAY 15, 2006 SHE WAS ELECTED AS A SECRETARY TREASURER OF THE LOS ANGELES COUNTY FEDERATION OF LABOR, A.F.L.-C.I.O. SHE'S THE FIRST WOMAN ELECTED TO THAT POSITION. AND SHE HAS KEPT -- SHE HAD KEPT THAT POSITION FOR 9 YEARS. AMONG HER MANY ACCOLADES, SHE HAS BEEN NAMED AMONG THE MOST INFLUENTIAL PEOPLE IN THE U.S. BY "HISPANIC" MAGAZINE, THE "CAPITAL WEEKLY" AND THE "MALIBU" MAGAZINE. AND THIS SUMMER SHE WAS INDUCTED INTO THE SMITHSONIAN MUSEUM WHERE SHE HOLDS A PLACE NEXT TO LABOR LEADER CAESAR E. CHAVEZ FOR HER TIRELESS WORK IN LABOR AND ON BEHALF OF IMMIGRANT WORKERS. [APPLAUSE.] MOST RECENTLY MARIA ELENA WAS NAMED INTERNATIONAL UNION VICE PRESIDENT FOR CIVIL RIGHTS, DIVERSITY, AND IMMIGRATION WITH UNITE HERE, A UNION WHICH REPRESENTS MORE THAN 270,000 MEMBERS IN VARIOUS INDUSTRIES IN THE U.S. AND CANADA. SHE SERVES AS VICE CHAIR FOR THE DEMOCRATIC NATIONAL COMMITTEE AND ALSO SITS ON THE BOARDS OF LANE, THE LOS ANGELES TOURISM AND CONVENTION BOARD, THE LOS ANGELES COALITION AND THE UNITED WAY OF GREATER LOS ANGELES SHE IS ALSO A MOTHER OF TWO SONS, MARIO AND MICHAEL AND A PROUD GRANDMOTHER TO HER TWO GRAND DAUGHTERS. THEREFORE TODAY WE CELEBRATE LABOR DAY IN LOS ANGELES COUNTY. WE CELEBRATE THE MANY CONTRIBUTIONS THAT MARIA ELENA DURAZO HAS MADE. AN EXTRAORDINARY DECORATED SERVICES ON THE FIGHT FOR WORKERS' RIGHTS. SI, SE PUEDE. THANK YOU SO MUCH. [APPLAUSE.] 

MARIA ELENA DURAZO: THANK YOU, SUPERVISOR SOLIS, AND ALL MEMBERS OF THE BOARD. I APPRECIATE THIS. AND ON BEHALF OF HARD WORKING MEN AND WOMEN WHO CONTRIBUTE SO MUCH TO THIS ECONOMY AND SPECIFIC INDUSTRY OF HOSPITALITY AND TOURISM, WHICH IS A VERY PROSPEROUS INDUSTRY, BUT I THINK ALSO ON BEHALF OF SO MANY PEOPLE WHO WORK HARD, THEY JUST WANT TO BE ABLE TO GET THE OTHER END OF THE BARGAIN, THE OTHER SIDE OF THE BARGAIN. WHEN YOU WORK REALLY HARD, SHOULDN'T YOU BE ABLE TO ACHIEVE THE AMERICAN DREAM AND NOT LIVE IN POVERTY? AND I SALUTE YOU ALL FOR THE PASSAGE OF THE INCREASE IN THE MINIMUM WAGE FOR THE COUNTY. BUT IN ADDITION TO THAT, WE NEED TO SUPPORT THE LAW OF THE LAND FOR COLLECTIVE BARGAINING. THAT IS THE LAW OF THE LAND OF THIS COUNTRY. AND WE NEED TO SUPPORT IT ACTIVELY BECAUSE WITHOUT ORGANIZED WORKERS, WE HAVE NO CHANCE OF REALLY BALANCING THINGS OUT IN THIS SYSTEM. SO JUST AS HOMEOWNERS AND DOCTORS AND PILOTS AND REALTORS HAVE THEIR COLLECTIVE VOICE, SO SHOULD WORKING FAMILIES. THANK YOU ALL VERY MUCH. THANK YOU, SUPERVISOR SOLIS. [APPLAUSE.] 

SUP. HILDA SOLIS: NEXT I HAVE THE HONOR OF INTRODUCING MR. SERGIO RASCON WHO BACK IN SEPTEMBER OF 2012 WAS ELECTED AS VICE PRESIDENT FOR THE LABORERS INTERNATIONAL UNION OF NORTH AMERICA AND PRESIDENT OF THE SOUTHERN CALIFORNIA COUNCIL OF LABORERS. CURRENTLY SERGIO RASCON SERVES AS THE NATIONAL EXECUTIVE BOARD OF THE LATIN AMERICAN COUNCIL FOR LABOR ADVANCEMENT AND NATIONAL VICE PRESIDENT. HE ALSO SERVES ON THE L.A. FEDERATION OF LABOR EXECUTIVE COBOARD. BORN IN 1953 IN SONORA, MEXICO MR. RASCON GREW UP IN THE SAN FERNANDO VALLEY. SHARING A STRONG PASSION FOR LABOR ORGANIZING, HE WAS NAMED LABOR FOREMEN FOR THE LABORER'S INTERNATIONAL UNION OF NORTH AMERICA, LIUNA, UNDER LOCAL 300 IN 1979 REPRESENTING WORKERS IN CONSTRUCTION, ASBESTOS ABATEMENT, MAINTENANCE, LANDSCAPING INDUSTRIES THROUGHOUT LOS ANGELES COUNTY. IN 1984, HE WAS NAMED AS THE OFFICIAL AGENT OF LIUNA, LOCAL 300 WHILE BECOMING A NATURALIZED U.S. CITIZEN THAT SAME YEAR. DEMONSTRATING A UNIQUE ABILITY TO ORGANIZE LABORERS IN THE COMMUNITY, HE WAS PROMOTED TO THE EXECUTIVE BOARD OF THE LABOR COUNCIL OF LATIN AMERICAN ADVANCEMENT LACLA IN 1989 AND LATER BUSINESS MANAGER AND PRESIDENT OF LOCAL 300. TIME AND TIME AGAIN SERGIO RASCON HAS PROVEN TO BE A "LUCHADOR," THAT MEANS A FIGHTER IN SPANISH, FOR LABOR ACCESS HUMAN JUSTICE, HUMAN DIGNITY AND RESPECT. HIS COMMITMENT TO IMPROVE THE LIVELIHOOD OF HIS WORKERS GOES BEYOND THE WORKPLACE. FIGHTING ALONGSIDE HIS MEMBERS HE HAS HELPED BRING GOOD JOBS, FAIR REPRESENTATION, TREATMENT AND WAGES AND A SEAT FOR LABORERS TO ADVOCATE FOR THEMSELVES AT THE BARGAINING TABLE. HE HAS FOUGHT TO PROVIDE WORKERS BETTER ACCESS TO HEALTHCARE AND TO EARN A COMPETITIVE PENSION PLAN. IN 2000 HE WAS ELECTED AS A GORE DELEGATE TO THE DEMOCRATIC NATIONAL CONVENTION AND AS A RESULT OF HIS LEADERSHIP, LOCAL 300 HAD THE LARGEST DELEGATION OF ANY UNION IN THE NATION IN THE 2000 D.N.C. CONVENTION. SERGIO HAS BEEN A VOICE FOR WORKERS, UNA VOZ PARA LAS TRABADAJORES. ON BEHALF OF L.A. COUNTY BOARD OF SUPERVISORS I AM PROUD TO RECOGNIZE HIM WITH THIS SCROLL FOR HIS NUMEROUS CONTRIBUTIONS FOR THE WORKING CLASS MEN AND WOMEN THAT HE REPRESENTS AROUND THE COUNTRY. THANK YOU SO MUCH, SERGIO. 

SERGIO RASCON: THANK YOU SO MUCH, SUPERVISOR SOLIS AND ALSO THE HONORABLE SUPERVISORS. THANK YOU FOR THE OPPORTUNITY. AS YOU CAN SEE, HARD WORK HAS ITS PROBLEMS LATER. SO I BELIEVE -- I DON'T WANT TO BLAME IT ON JUST WORK, BUT YOU CAN SEE I'M HALF A MAN TODAY. BUT AGAIN FROM THE HUMBLE BEGINNINGS OF A SHOE SHINE BOY TO, YOU KNOW, PICKING ORANGES, BECOMING A LABORER, FOREMAN, GENERAL FOREMAN AND THEN, YOU KNOW, THE BUSINESS MANAGER OF ONE OF THE LARGEST IF NOT THE LARGEST UNION TODAY IN THE CONSTRUCTION INDUSTRY UNDER OUR INTERNATIONAL, WHICH MAKES ME VERY PROUD TO BE PART OF BUT AS I'VE ALWAYS SAID THAT IT'S NOT A ONE-PERSON ISSUE HERE. IT'S PART OF A TEAM THAT MAKES EVERYTHING HAPPEN. AND I'M VERY PROUD TO BE GIVEN THE OPPORTUNITY BY THE VERY SAME PEOPLE THAT I WORKED FOR TO BE THEIR BUSINESS MANAGER. BUT I'M ALSO VERY PROUD TO HAVE PEOPLE WITHIN THE MOVEMENT THAT UNDERSTAND AND LISTEN TO THE WORKING MEN AND WOMEN AND FIGHT FOR THE MEN AND WOMEN SO HARD TO MAKE SURE THAT WE HAVE A DECENT LIFE AND THAT IS SUPERVISOR SOLIS. SO WE THANK HER FOR WHAT SHE DOES. AND WE THANK THE REST OF THE SUPERVISORS FOR WHAT THEY DO BECAUSE IT IS OBVIOUS THAT THEY ARE NOT HERE ONLY BECAUSE THEY LOVE THE ISSUE OF POLITICS BUT ALSO BECAUSE THEY REPRESENT THE PEOPLE IN THE RIGHT MANNER. THANK YOU SO MUCH. [APPLAUSE.] 

SUP. HILDA SOLIS: NEXT I'D LIKE TO CALL UP AT THIS TIME MR. RICK ICAZA WITH THE UNITED FOOD AND COMMERCIAL WORKERS UNION LOCAL 770. WE HONOR MR. ICAZA AS ANOTHER GREAT LEADER AND PIONEER FOR WORKERS' RIGHTS. MR. ICAZA IS A NATIVE AND LIFE-LONG RESIDENT OF LOS ANGELES WHO BEGAN HIS DISTINGUISHED CAREER BACK IN 1956 AS A MEMBER OF THE RETAIL CLERKS UNION LOCAL 770. IN 1981, HE BECAME PRESIDENT OF LOCAL 770 WHICH BECAME THE UNITED FOOD AND COMMERCIAL WORKERS' UNION. HE HAS BEEN INVOLVED AND HAS SUCCESSFULLY SHOWN GREAT LEADERSHIP IN FIGHTING FOR THE RIGHT TO HAVE AFFORDABLE HEALTHCARE AND LIVABLE WAGES DURING U.F.C.W. LOCAL STRIKE DURING 2003 AND 2004. HE HAS FOUGHT FOR WORKERS' RIGHTS TO ORGANIZE AND DEMAND JUST COMPENSATION AND EMPLOYEE SAFETY FOR MANY CORPORATIONS SUCH AS WALMART. HE HAS CHAMPIONED THE RIGHTS OF UNDOCUMENTED WORKERS AND CAMPAIGNED FOR L.G.B.T. EQUALITY. HE ALSO SERVES ON THE BOARD OF TRUSTEES FOR SOUTHERN CALIFORNIA UNITED FOOD WORKERS UNION AND FOOD EMPLOYERS JOINT BENEFIT AND PENSION FUNDS AND IS FOUNDER OF LOCAL 770 ICAZA FOUNDATION. IN ADDITION TO SERVING AS LOCAL 770 PRESIDENT, MR. ICAZA IS ALSO PRESIDENT OF THE LOS ANGELES COUNTY FEDERATION OF LABOR, VICE PRESIDENT FOR THE LABOR COUNCIL OF LATIN AMERICAN ADVANCEMENT AND ALSO PRESIDENT OF THE CALIFORNIA LABOR FEDERATION. MR. ICAZA HOLDS A BACHELOR OF SCIENCE IN BUSINESS ADMINISTRATION FROM U.C.L.A. AND PURSUED COURSES AT U.S.C. GOLD SCHOOL OF LAW. HE IS MARRIED WITH THREE CHILDREN AND FOUR GRANDCHILDREN WHO ARE DEAR AND VERY PRECIOUS TO HIM. THEREFORE TODAY WE ACKNOWLEDGE ON LABOR DAY IN LOS ANGELES COUNTY MR. RICARDO, RICK, ICAZA FOR HIS LONG YEARS OF SERVICE DEDICATED NOT ONLY TO THE MEMBERS OF U.F.C.W. BUT TO ALL THE WORKING MEN AND WOMEN HE REPRESENTS. THANK YOU, RICK. [APPLAUSE.] 

RICK ICAZA: YOU KNOW, I'M NOT USUALLY INVITED TO THESE OPERATIONS. I'M USUALLY LEADING PROTESTS. IT'S UNUSUAL TO BE HERE TODAY. I WANT TO EXPRESS MY SINCERE APPRECIATION TO SUPERVISOR SOLIS AND THE ENTIRE BOARD OF SUPERVISORS FOR THIS SPECIAL RECOGNITION. YOU SEE THIS AWARD FROM SUPERVISOR SOLIS IS EVEN MORE SPECIAL BECAUSE OF HER DEDICATION AND COMMITMENT TO IMPROVING THE LIVES OF WORKING MEN AND WOMEN. SUPERVISOR SOLIS IS A CHAMPION OF THE PEOPLE. I ACCEPT THIS HONOR ON BEHALF OF THE 32,000 MEMBERS OF U.F.C.W. LOCAL 770, EACH AND EVERY ONE, EACH WORKING MAN AND WOMAN PROVIDE QUALITY SERVICES AND THEY IMPACT AND IMPROVE THE QUALITY OF LIFE FOR EVERY RESIDENT OF LOS ANGELES COUNTY. TODAY'S HONOR IS VERY SPECIAL AND I TRULY APPRECIATE RECEIVING IT FROM SUPERVISOR SOLIS. LASTLY, I ALSO WANT TO RECOGNIZE AND CONGRATULATE MARIA ELENA DURAZO, SERGIO RASCON, LARRY FRANK, THESE INDIVIDUALS ABSOLUTELY MEET THE DEFINITION OF CHAMPIONS OF SOCIAL JUSTICE. THANK YOU SO VERY MUCH, SI, SE PUEDE. [APPLAUSE.] 

SUP. HILDA SOLIS: LAST BUT NOT LEAST I'D LIKE TO BRING UP LARRY FRANK AND THE STAFF AT L.A. TRADE TECH. LARRY AS YOU KNOW IS PRESIDENT OF THAT PRESTIGIOUS COMMUNITY COLLEGE. IN THE SHORT TIME HE'S BEEN THERE HE'S DONE SO MUCH PHENOMENAL WORK. I LOOK FORWARD TO GREAT THINGS THIS HE'LL CONTINUE TO ACCOMPLISH WHILE HE'S PREPARING OUR FUTURE WORKFORCE. YOUR EFFORTS IN LEADERSHIP ARE KEY TRAITS THAT PERMEATE THROUGHOUT L.A.T.T.C. CAMPUS. FOUNDED BACK IN 1925, THE LOS ANGELES TRADE TECHNICAL COLLEGE IS THE OLDEST COMMUNITY COLLEGE IN I BELIEVE THE COUNTY IF NOT THE STATE OF LOS ANGELES AND THE STATE, YEAH. SINCE OPENING THE LABOR CENTER BACK IN 1978, THIS CAMPUS HAS TRAINED MORE THAN 25,000 UNION MEMBERS, ACTIVISTS AND LEADERS. THE CENTER HAS HELPED SO MANY WORKERS THROUGHOUT THE REGION. THE CENTER BRINGS TOGETHER HUNDREDS OF WORKERS, STUDENTS, FACULTY AND POLICYMAKERS EACH SEMESTER TO ADDRESS THE MOST CRITICAL ISSUES OF WORKING CLASS AMERICANS TODAY. THEY HAVE TRAINED STUDENTS ON POLICY RESEARCH SO THEY CAN ADVOCATE FOR JOB CREATION AND LIVABLE WAGES. L.A.T.T.C. HAS DEVELOPED A CUTTING EDGE CURRICULUM THAT HAS PREPARED STUDENTS FOR EMPLOYMENT IN LABOR RELATIONS, COMMUNITY DEVELOPMENT AND ALLOWING STUDENTS TO ENGAGE RESIDENTS AND GOVERNMENT AND BUSINESSES LOCALLY AND NATIONALLY. STUDENTS HAVE ADVOCATED FOR AN IMPROVED QUALITY OF LIFE FOR WORKING CLASS AMERICANS BY STAUNCHLY SUPPORTING WORKERS RIGHTS, COLLECTIVE BARGAINING AND ENGAGING RESIDENTS IN PUBLIC AFFAIRS. YOU HAVE EMPOWERED SO MANY STUDENTS AND PEOPLE AROUND HERE. AND WE GIVE YOU THIS PARTICULAR COMMENDATION FOR THE WORK THAT YOU'VE DONE, LARRY, AND ALL THE STAFF BEHIND YOU THAT HAVE HELPED TO MAKE THIS CAMPUS SO GREAT. I HAD THE PRIVILEGE OF WORKING WITH YOU WHEN I WAS SECRETARY OF LABOR, AND YOU DID AN OUTSTANDING JOB TO HELP PUT PEOPLE BACK TO WORK DURING THE DIREST TIMES DURING THE RECESSION THAT WE EXPERIENCED. SO I THANK YOU AND COMMEND YOU AND LOOK FORWARD TO WORKING WITH YOU HERE IN THE COUNTY OF LOS ANGELES. [APPLAUSE.] 

LARRY FRANK: I THANK YOU, SUPERVISOR SOLIS AND THE BOARD OF SUPERVISORS, THANK YOU SO MUCH FOR THIS HONOR FOR TRADE TECH COLLEGE. SO IT IS AN HONOR FOR THE CAMPUS. AND WE KNOW THAT WE ARE THE CARETAKERS OF THAT HONOR, NOT THE RECIPIENTS, IN SOME WAYS. IT'S 90 YEARS THAT TRADE TECH HAS SERVED LOS ANGELES. WE HAVE 23,000 STUDENTS. WE HAVE 1,400 VETERANS. WE HAVE 923 FORMER FOSTER YOUTH GOING TO TRADE TECH COLLEGE. WE HAVE ABOUT 1,400 FOLKS IN OUR GAIN CALWORKS, THE LARGEST GAIN CALWORKS PROGRAM IN PARTNERSHIP WITH THE COUNTY OF ANY COLLEGE IN CALIFORNIA TIMES TWO. AND I HAVE DIRECTOR HERE LINDA IS RIGHT HERE. I'M GOING TO MAKE DARLENE KUBA JOIN US, SORRY. SHE THOUGHT SHE COULD AVOID THIS, BUT SHE HAS ACTUALLY CHAIRED OUR BOARD OF OUR FOUNDATION FOR THE LAST SEVERAL YEARS IN HELPING TO BRING US BACK, DID A GREAT JOB, HELPING TRADE TECH IN RAISING THE MONEY FOR SKILLS AND TOOLS FOR THE TRADE. SPEAKING OF SKILLS, THE FOLKS IN THE RED JACKETS HEREY I JUST WANT TO INTRODUCE MARTIN TORRES RIGHT HERE IS A GOLD MEDAL WINNER, ONE OF 14 GOLD MEDALISTS FOR SKILLS U.S.A. IN ELECTRICAL. AND HE'S NOW WORKING DOWN I.B.E.W. LOCAL 441 DOWN AT DISNEYLAND. TOOK HIM FOUR MONTHS TO BECOME THE LEAD ELECTRICIAN. [APPLAUSE.] SO WE BELIEVE IN AWARDS, OUR GOLD MEDAL WINNER IN DIESEL MECHANICS IS ALREADY WORKING IN THE INDUSTRY AND IS MAKING A NAME FOR HIMSELF. BUT WE HAVE A REMARKABLE PROGRAM AND TRAINING FOR INDUSTRY. SO CAREER TECHNICAL EDUCATION HAS GONE FROM BEING A STEPCHILD TO BEING ALMOST A FAVORED CHILD. IT'S BECAUSE WE ACTUALLY DO PARTNER WITH THE MIDDLE CLASS JOBS AND CONNECT PEOPLE TO THE GREAT JOBS. AND WE'RE HOPING TO DO MORE PARTNERING WITH THE COUNTY OF LOS ANGELES. WE HAVE A GREAT PARTNERSHIP WITH METRO THANKS TO YOUR LEADERSHIP. WE JUST GOT A DESIGNATION THANKS TO THE GRANT WRITING AND THE WORK OF THE VICE PRESIDENT TO BE A TRANSIT INSTITUTE, AN F.T.A.-RECOGNIZED TRANTSIT INSTITUTE THE ONLY COMMUNITY COLLEGE IN THE COUNTY TO DO SO. I WANT TO CONTINUE TO WORK WITH METRO WITH FLEET SERVICES WITH ALL THE FOLKS THAT WE THINK WE CAN REALLY BRING SUPPORT TO. SO I WANT TO THANK YOU FOR THE HONOR FOR THE COLLEGE. WE KNOW THIS IS FOR THE 90 YEARS OF WORK THAT'S HAPPENED DOWN THE STREET BY THE 985 STAFF AND FACULTY AND ADMINISTRATORS AND THE 23,000 STUDENTS. THANK YOU SO MUCH. [APPLAUSE.] I'M SORRY. JOHN MCDOWELL. I'D BE REMISS NOT RECOGNIZING HIM, 37 YEARS AGO STARTED THE TRADE TECH LABOR CENTER AND REALLY BEEN THE PERSON THAT BUILT SO MANY OF THE PARTNERSHIPS BETWEEN OURSELVES AND LABOR. THANK YOU, JOHN MCDOWELL. [APPLAUSE.] 

SUP. ANTONOVICH, MAYOR: I'M GOING TO MOVE TO REFER ITEM 13 BACK TO OUR OFFICE. THERE IS A DISCREPANCY ON THE FEES ON THAT SO WE CAN GET THAT RESOLVED. I'LL MOVE AND SECONDED BY SUPERVISOR KUEHL TO REFER 13 BACK TO MY OFFICE WITHOUT OBJECTION SO ORDERED. WE'RE GOING TO MOVE INTO EXECUTIVE SESSION AND THEN COME BACK FOR THE REST OF THE AGENDA. 

AVIANNA URIBE, ACTING ASS'T. EXEC. OFCR: IN ACCORDANCE WITH BROWN ACT REQUIREMENTS NOTICE IS HEREBY GIVEN THAT THE BOARD OF SUPERVISORS WILL CONVENE IN CLOSED SESSION TO DISCUSS ITEM CS-1, CONFERENCE WITH LEGAL COUNSEL REGARDING EXISTING LITIGATION, ITEM NO. CS-2, CONFERENCE WITH LEGAL COUNSEL REGARDING SIGNIFICANT EXPOSURE TO LITIGATION, ITEM CS-3, CONFERENCE WITH LABOR NEGOTIATOR SACHI HAMAI AND DESIGNATED STAFF AS INDICATED ON THE POSTED ON THE AGENDA. 
[CLOSED SESSION]
[GAVEL] 

AVIANNA URIBE, ACTING ASS'T. EXEC. OFCR: ON ITEM CS-1, CS-2 AND CS-3, NO REPORTABLE ACTION. 

SUP. ANTONOVICH, MAYOR: OKAY, WE'LL DO S-1. THAT'S THE 1:30 SHERIFF- INSPECTOR GENERAL REPORT. IT WAS RELATED TO THE SHERIFF. YOU'RE NOT ON. TRY IT. 

TERRI MCDONALD, ASST SHERIFF: GOOD AFTERNOON, MR. MAYOR, MADAM SUPERVISORS. TERRI MCDONALD, ASSISTANT SHERIFF, LOS ANGELES COUNTY SHERIFF'S DEPARTMENT. 

MAX HUNTSMAN: MAX HUNTSMAN, INSPECTOR GENERAL. 

DAVE WALTERS: DAVE WALTERS, LOS ANGELES COUNTY SHERIFF'S DEPARTMENT. 

KATHLEEN BELT: KATHLEEN BELT, ASSISTANT INSPECTOR GENERAL. 

STEVE GROSS: STEVE GROSS, LOS ANGELES COUNTY SHERIFF'S DEPARTMENT. 

ASST. SHERIFF MCDONALD: THAT ALMOST TOOK UP THE 15 SECONDS FOR THE SLIDE TO COME UP. SO HERE'S OUR UPDATE DISCUSSION ON THE CITIZENS COMMISSION ON JAIL VIOLENCE. AS WITH THE LAST REPORT, WE'RE REPORTING SIMPLY ON THE THINGS THAT ARE STILL OUTSTANDING FROM THE PRIOR REPORT. REALLY, NOT MUCH HAS CHANGED SINCE LAST TIME. THE DATA TRACKING SYSTEM IS ON TARGET. IT'S IN I.T. BODY SCANNERS, WE'RE WORKING WITH THE CHIEF EXECUTIVE OFFICE TO DO A SUPPLEMENTAL BUDGET REQUEST FOR BODY SCANNERS. WE'VE ASKED THE CONSULTANTS TO COME AND TAKE A LOOK IN PARTNERSHIP WITH AT LEAST ONE BOARD OFFICE SO WE'LL BE ABLE TO DISCUSS THAT ONCE THE C.E.O. STAFFS HAVE HAD AN OPPORTUNITY TO VET THAT. C.C.T.V., IN A PRIOR BOARD MEETING THE BOARD HAD ASKED US TO LOOK TO SEE WHAT IT WOULD COST TO TAKE OR EXPEDITE THE CAMERA SYSTEM. WE SUBMITTED A JUNE I THINK 19TH REPORT TO YOUR BOARD RECOMMENDING THAT IF YOU CHOOSE TO WANT TO EXPEDITE IT, IT WOULD COST ABOUT -- UP TO $940,000 PRIMARILY FOR CONTRACTORS AND CONSULTANTS. AND THAT WOULD EXPEDITE THE VIDEO PROJECT BY 27 MONTHS. SO WE SUBMITTED BOTH OF THOSE DOCUMENTS SINCE WE LAST MET. MOST OF THE OUTSTANDING ISSUES ARE HIRING. THE PHASE 2 HIRING, WE HAD FUNDING FOR BUT THERE MAY BE SOME CHALLENGES WITH THE HIRING ITSELF, PROBABLY THE LARGEST ONE WAS THE IMPACT AUDITORS. THE GOOD NEWS IS -- AND I HAVE BROUGHT THE CAPTAIN WITH ME -- THE GOOD NEWS IS THE EXAM'S OUT, SO WE SHOULD BE ABLE TO RESOLVE THAT ONE. IN THE PHASE 3 HIRING, AS I MENTIONED I THINK LAST TIME, SOME OF THE POSITIONS WERE DEFERRED BECAUSE OF THE OVERALL D.O.J. AND ROSAS REQUESTS. AND SO WE WORKED WITH THE CHIEF EXECUTIVE OFFICE TO DEFER SOME ITEMS AND SLIP SOME ITEMS IN. SO IN 4.12 IS AN EXPANSION TO IMPACT. 6.03 WAS TRAINING SERGEANTS FOR CUSTODY. WE'VE RECEIVED THOSE. 7.15 WAS THREE I.T. FOLKS TO HELP WITH THE C.C.T.V. EXPANSION AND THEN I.A.B., I.C.I.B. WAS TO ENHANCE THEIR INVESTIGATIVE STAFF. TRAINING, WE ARE ABOVE OR BEYOND TARGET WITH C.C.J.V. ON ALL OF OUR TRAINING DOMAINS. OF COURSE WE HAVE NEW TRAINING DOMAINS WITH D.O.J. AND ROSAS, BUT AS FAR AS C.C.J.V., YOU CAN SEE THAT THE GOALS AND THE ACTUALS, WE'VE EXCEEDED EVERY GOAL WITH THAT. INMATE GRIEVANCES, THIS HAS BECOME A HUGE PART OF THE ROSAS SETTLEMENT. WE'RE GRATEFUL TO THE BOARD AND THE CHIEF EXECUTIVE OFFICE FOR WORKING WITH US TO ENHANCE THE NUMBER OF GRIEVANCE STAFF. WE'VE ALSO HAD OUR TABLET PILOT PROGRAM, I TESTIFIED BEFORE. WE'VE GOT 500 NEW TABLETS READY TO GO AS SOON AS WE CAN DO THE INFRASTRUCTURE TO PUT THEM IN THE HOUSING UNITS. AND IT MAKES THE GRIEVANCES MORE ACCESSIBLE TO THE INMATES. IT MAKES REPORTING BETTER. IT'S JUST CLEANER. SO HOPEFULLY BY THE NEXT TIME WE TESTIFY, SOME OF THOSE 500 WILL BE UP AND IN PLACE. I THINK AT A CERTAIN POINT WE'LL NEED TO GET SOME GUIDANCE ON WHERE WE HAVE OVERLAP BETWEEN C.C.J.V. AND THESE COURT CASES, HOW DO WE BEST REPORT BACK TO THE BOARD ON THOSE? BECAUSE THIS AGAIN IS A BIG PART OF ROSAS. 

SUP. HILDA SOLIS: AS YOU BRING THAT UP, GIVEN THE PREVIOUS CHARTS THAT YOU SHARED THAT YOU'VE HAD SOME VERY SIGNIFICANT -- THAT CHART -- SOME VERY SIGNIFICANT IMPROVEMENTS, HOW ARE WE GOING TO MEASURE THAT AGAINST THE ROSAS? WHAT'S GUIDING US? 

ASST. SHERIFF MCDONALD:THESE WERE C.C.J.V.-RECOMMENDED TRAINING CLASSES. UNDER ROSAS, WE HAVE ENTIRELY DIFFERENT TRAINING CLASSES. A GOOD EXAMPLE THE BOARD AUTHORIZED AND FUNDED THE C.I.T. TRAINING WHICH IS THE KIND OF ROLE PLAYING MENTAL HEALTH WEEK LONG TRAINING. SO WE HAVE THE SAME TRACKING MECHANISM FOR HOW WE'RE DOING WITH THOSE TARGETS WHETHER IT'S USE OF FORCE TRAINING OR THAT C.I.T. TRAINING. BUT IT REALLY HAS LITTLE TO DO WITH THIS. THERE'S NOT MUCH OVERLAP BETWEEN THE TWO. THERE IS A FORCED ETHICS CLASS THAT THEY MONITOR. AND THE GOOD NEWS IS THEY CAME IN AND MONITORED TO SEE HOW WE WERE DOING IT AND THEY ACCEPTED OUR CURRENT TRAINING. SO THE GOOD NEWS IS WE DON'T HAVE TO GO BACK AND RETRAIN ON THE ETHICS PORTION. SO THOSE WERE THE OUTSTANDING ITEMS FROM C.C.J.V. I ALWAYS WANT TO TALK A LITTLE ABOUT HOW FORCE IS LOOKING FOR US. AS A REMINDER, FORCE WAS TRACKED IN TWO DIFFERENT WAYS, PRE AND POST C.C.J.V. FROM 2005 YOU'VE GOT THE YELLOW AND THE GREEN BARS. YELLOW BAR WITH SIGNIFICANT FORCE AND GREEN BAR WAS LESS SIGNIFICANT. YELLOW COULD MEAN SOMEBODY WAS SERIOUSLY INJURED OR THE FORCE, THE CHOICE OF FORCE OPTIONS WAS MORE SERIOUS. AFTER C.C.J.V. AND STARTING IN EARLY 2013, WE WENT AWAY FROM THE TERM "SIGNIFICANT" AND "LESS SIGNIFICANT" AND WE WENT TO CATEGORY 1, CATEGORY 2 AND CATEGORY 3. AND SO WHEN YOU LOOK AT THIS CHART, THE CATEGORY 1 FORCES ARE YOUR BLUE CHARTS. AND YOU CAN SEE THAT THAT'S THE MAJORITY OF THE FORCE, WHICH IS REALLY NO INJURY, NO COMPLAINT OF PAIN, NO MAJOR FORCE OPTION, WHICH IS SUBSTANTIALLY DIFFERENT THAN THE PRIOR YEARS WHERE INMATES WERE BEING INJURED MORE READILY THAN TODAY. THE RED REPRESENTS CATEGORIES 2 AND 3. IT'S IMPORTANT TO POINT OUT THAT THERE MAY BE NO INJURY IN THE RED, THOUGH. IT COULD BE THE INMATE ALLEGED HE WAS HURT OR THE TYPE OF FORCE THAT WE USE. AS I MENTIONED LAST TIME, THERE HAVE BEEN NO SIGNIFICANT INMATE INJURIES IN FORCE THAT HAVE BEEN RELATED TO ANYTHING OTHER THAN DORM INCIDENTS WHERE WE HAPPENED TO DEPLOY A LARGE-SCALE MUNITIONS IN THERE TO STOP RIOTING WHERE THEY GET HIT INADVERTENTLY WITH A PROJECTILE. 

SUP. HILDA SOLIS: WHAT A BIG DROP FROM 2014 TO 2015 ALREADY, RIGHT? 

ASST. SHERIFF MCDONALD: WELL WE'RE HALF A YEAR. SO IF WE WERE TO PROJECT 2015, I THINK WE'LL BE ABOUT -- THE RED BELOW, MADAME SUPERVISOR, YOU CAN SEE WE'VE HAD 333 USES OF FORCE WHEN THIS CHART WAS DONE AND I'M SORRY, THE EXACT DATE SHOULD HAVE BEEN ON THE CHART AND IT'S NOT. BUT IT WASN'T A FULL HALF YEAR, I DON'T THINK. I THINK LAST TIME I LOOKED WE WERE TRENDING ABOUT 700 USES OF FORCE THIS YEAR. IF YOU GO ALL THE WAY BACK TO 2006 WE HAD 1,200. AND YOU WOULD THINK, WELL, GOSH, WE'RE NOT MUCH BELOW THAT, BUT WE WEREN'T REPORTING FORCE TO THE DEGREE AND MAGNITUDE PRIOR TO PROBABLY 2014. THEY WOULD NOT HAVE REPORTED A USE OF FORCE WHERE THERE WAS A MINOR STRUGGLE, MINOR FORCE AND NO INJURY. IT JUST WOULDN'T HAVE ENDED UP IN THE FORCE PACKAGE. IT'S INTERESTING. WE WERE WITH COOK COUNTY AND RIKERS ISLAND GOING THROUGH WHAT ARE SIMILAR CHALLENGES FOR THE SYSTEMS A COUPLE WEEKS AGO AND WE TALKED ABOUT FORCE ITSELF. AND L.A. COUNTY, IF I PROJECTED IT TO ITS MOST EXTREME THIS YEAR AT 900 CASES FOR L.A. COUNTY, IF YOU WERE TO ADD COOK COUNTY AND RIKERS AND OUR POPULATION IS THE SAME AS COOK COUNTY AND RIKERS COMBINED THEIR FORCE CASES ARE 6,200 BY WAY OF PUTTING IN SOME PERSPECTIVE. SO THAT'S KIND OF WHERE WE ARE WITH FORCE. I'M AVAILABLE FOR ANY QUESTIONS OR ALLOW MR. HUNTSMAN TO GIVE FEEDBACK. AND I HAVE DAVE WALTERS FOR ANY IMPACT-RELATED QUESTIONS. 

SUP. ANTONOVICH, MAYOR: HAVE EVERYBODY SPEAK AND THEN I'LL HAVE SOME QUESTIONS. 

MAX HUNTSMAN: YES, MR. MAYOR, I HAVE NOTHING TO ADD OTHER THAN TO ECHO WHAT ASSISTANT SHERIFF MCDONALD SAID ABOUT ROSAS NOW BECOMING I THINK THE PRIMARY WAY BY WHICH WE'LL MEASURE SUCCESS. AND SO THE C.C.J.V. RECOMMENDATIONS, THOSE ONES THAT HAVE BEEN FINISHED OF COURSE WE'RE NOT REPORTING ANYMORE. THERE ARE A FEW THAT WE ARE STILL WORKING ON. AND THEN THERE ARE SOME THAT REQUIRE EITHER ADDITIONAL FUNDING OR HAVE BEEN DEFERRED BECAUSE OF THE ROSAS, WHICH ARE OF CONCERN TO ME WHICH IS THE IMPACT ON THE I.A. FUNDING. BUT AS THIS BOARD KNOWS, YOU'VE GOT TO SPEND YOUR DOLLARS WISELY IN A VARIETY OF DIFFERENT WAYS NOW. AND SO ROSAS IS GOING TO BE DRIVING THINGS IN THE FUTURE. 

ASST. SHERIFF MCDONALD: WE'RE AVAILABLE FOR ANY QUESTIONS. 

SUP. ANTONOVICH, MAYOR: I'M GOING TO THANK YOU FOR EXPEDITING THE CAMERAS THAT WE RAISED AT THE LAST MEETING AS TO HOW WE COULD GET THE PROCESS QUICKER AND FASTER BECAUSE IT PROTECTS EVERYBODY IN THE SYSTEM FORWARD. THE 60 RECOMMENDATIONS, YOU HAVE 54 THAT HAVE BEEN IMPLEMENTED. THAT'S VERY GOOD SUCCESS. AND 3 PARTIALLY ARE BEING IMPLEMENTED AND 3 ARE IN PROGRESS. SO WE ARE STILL MOVING FORWARD. AND 3 OF THE 63 ARE NON-SHERIFF. SO WE'RE DEALING WITH THOSE ISSUES, AS WELL. BUT ONE OF THE -- FOR NEXT WEEK OR THE WEEK AFTER, WE HAD THE AMERICAN CIVIL LIBERTIES UNION, WE WERE SPENDING HUNDREDS OF THOUSANDS OF DOLLARS IN THE JAIL TO SEE THAT EVERYTHING WAS GOING WELL AND TO BE THE EYES OF THE PUBLIC, SO TO SAY. AND, YET, WE HAD ALL OF THESE ALLEGATIONS WHICH WERE PROVEN TO BE FACTUAL BECAUSE OF CONVICTIONS THAT HAVE TAKEN PLACE. I WOULD LIKE TO KNOW HOW MUCH MONEY DID WE PAY THE A.C.L.U. TO OBSERVE THE CONDITIONS OF THE JAIL? AND WHAT DID THEY ACTUALLY DO TO STOP SOME OF THE ABUSES THAT WE'VE HAD PEOPLE CONVICTED FOR THAT OCCURRED DURING THEIR WATCH? IF WE COULD JUST HAVE THAT FINANCIAL INFORMATION, THAT WOULD BE VERY IMPORTANT. BUT I WANTED THE THANK YOU ALL FOR WORKING TOGETHER. ANY OTHER QUESTIONS THAT WE HAVE? SUPERVISOR SOLIS. 

SUP. HILDA SOLIS: THANK YOU. AND THANK YOU FOR THE PRESENTATION. I WANTED TO ASK THE SHERIFF. TERRI, IF YOU CAN GIVE US AN IDEA -- AND I WANT TO COMMEND YOU ALL FOR EXPEDITING THE BODY SCANNERS AND WANTED TO KNOW EXACTLY IF THERE HAS BEEN A FORMLAL REQUEST SUBMITTED FOR THE SUPPLEMENTAL BUDGET? 

ASST. SHERIFF MCDONALD: YES. 

INTERIM C.E.O. SACHI HAMAI: YES, THE REQUEST CAME IN THROUGH THE C.E.O.'S OFFICE. 

SUP. HILDA SOLIS: CAN YOU DESCRIBE WHAT WE'RE LOOKING AT WITH PERSONNEL? 

INTERIM C.E.O. SACHI HAMAI: IT'S IN THE SUPPLEMENTAL BUDGET. IT WILL COME FORWARD AT THE END OF SEPTEMBER. I THINK IT'S A LITTLE OVER $900,000. I DON'T REMEMBER THE DETAILS. AND PERSONNEL? 

ASST. SHERIFF MCDONALD: I'M SORRY. I SHOULD HAVE BROUGHT IT WITH ME. I APOLOGIZE. I THINK IT WAS ROUGHLY 60 ITEMS OR SO SPREAD OVER MULTIPLE IMPLEMENTATION YEARS. BECAUSE THESE PIECES OF EQUIPMENT ARE LARGE AND THEY TAKE TIME TO BUILD. SO WE WOULD BUILD IT OUT OVER YEARS. AND I CAN GET YOU THE DOCUMENT. WE NORMALLY, THOUGH, MADAME SUPERVISOR, WOULD MAKE SURE THE C.E.O.'S OFFICE HAS VETTED IT AND APPROVED IT AND WORKED IT THROUGH HER SHOP. BUT IT WAS ABOUT 60 POSITIONS GROWING OVER TIME TO BE ABLE TO IMPLEMENT AT VARIOUS LOCATIONS. 

SUP. HILDA SOLIS: AND I GUESS ONE OF MY CONCERNS WOULD BE THE SOONER THE BETTER OBVIOUSLY BECAUSE WE'VE HAD PRIOR TO YOUR COMING ON BOARD WE HAD NUMEROUS LAWSUITS REGARDING THE SEARCHES IN AND OF THEMSELVES. SO I THINK THAT THAT WOULD HELP US HOPEFULLY MOVE THIS ALONG QUICKER IF WE CAN THINK THAT WE CAN REDUCE OUTSIDE LITIGATION. 

ASST. SHERIFF MCDONALD: WE APPRECIATE YOUR SUPPORT AND ACTUAL THOUGHTFUL MOTIVATION TO GET IT FORWARD. SO WE WERE ABLE TO PUT THAT FORWARD, MA'AM. 

SUP. HILDA SOLIS: ONE OTHER QUESTION WITH RESPECT TO THE IMPACT INTERNAL MONITORING, PERFORMANCE AND AUDITS AND ACCOUNTABILITY, I WANTED TO -- I KNOW THAT YOU HAD 8 AUDITS THAT WERE DONE SO FAR. WHAT HAPPENS AS A RESULT OF THOSE AUDITS AFTER? WHAT ARE YOUR FINDINGS OR WHAT ARE YOUR RECOMMENDATIONS? 

DAVE WALTERS: YES, MA'AM, THANK YOU. DAVE WALTERS. TODAY, SINCE THAT BOARD LETTER, WE'VE ACTUALLY COMPLETED 10 AUDITS. 2 OF THEM HAD SEVERAL RECOMMENDATIONS AND THE OTHER 2, WELL, LET ME STEP BACK FOR A SECOND. 7 OF THE AUDITS WERE RELATED TO ONE SUBJECT AND THEY ALL HAD ONE PRIMARY RECOMMENDATION OUT OF CUSTODY AND CUSTODY, IS IN FACT, IS WORKING ON THE POLICY. IT WAS THE PERSONHEL ROTATION AUDIT. WE ALSO DID A FOOT-PURSUIT AUDIT THAT HAD 11 RECOMMENDATIONS. AND THERE'S A COMMANDER'S COMMITTEE THAT'S BEEN PLACED TOGETHER. AND THEY'RE WORKING ON GOING THROUGH EACH OF THE RECOMMENDATIONS AND WHAT WILL BE IMPLEMENTED AND WHAT WILL NOT BE. THE OTHER TWO AUDITS HAD VERY MINOR RECOMMENDATIONS BECAUSE THERE WAS SUBSTANTIAL COMPLIANCE 

SUP. HILDA SOLIS: HAS ANY OF THAT INFORMATION COME BACK TO US? 

DAVE WALTERS: ACTUALLY, IT IS. I BELIEVE -- AND IT'S A GREAT QUESTION. I CAN FOLLOW-UP ON. WHEN WE DID OUR VERY FIRST AUDIT WHICH WAS THE UNIFORM CRIME REPORTING AUDIT THE STATISTICAL CODES WE USED FOR CRIMES, WE DID SEND A COPY OF THE AUDIT WITH A COVER LETTER TO YOUR BOARD. AND I CAN FOLLOW-UP ON THE OTHERS TO ENSURE THAT THAT'S ACTUALLY HAPPENED. 

ASST. SHERIFF MCDONALD: AND THERE'S A CORRECTIVE ACTION PLAN. IF IT'S A CUSTODY AUDIT, WE WILL GET THE AUDIT, WE'LL DO A CORRECTIVE ACTION PLAN. IT'S NOT THAT WE'LL ALWAYS AGREE WITH THE AUDITORS. THAT'S WHAT DAVE IS SAYING. THE AUDITORS MIGHT MAKE A LIST OF RECOMMENDATIONS AND THEN A COMMANDER'S PANEL SAYS WE'RE NOT GOING TO DO THAT BUT AT LEAST WE THOUGTFULLY DELIBERATE SO CERTAINLY WE CAN GET YOU A COPY OF THE AUDITS. 

SUP. HILDA SOLIS: LASTLY, WITH THE IPADS THAT I CAN RECALL WHEN WE TOOK THE TOUR OUT AT THE JAILS, WE DID SEE THOSE AND YOU WERE SHOWING INDICATING HOW INMATES WERE ABLE TO RESPOND OR REGISTER THEIR COMPLAINTS. I UNDERSTAND THAT WE HAD NUMEROUS, 290 COMPLAINTS? I'M JUST WONDERING IF I CAN GET A SENSE OF WHAT THOSE ARE. WHAT DID THAT LOOK LIKE? 

ASST. SHERIFF MCDONALD: THEY VARY. HISTORICALLY WHAT'S HAPPENED IS WHEN INMATES PUT IN A DOCUMENT, THEY'RE ALL TREATED LIKE COMPLAINTS AND THEY'RE NOT ALL COMPLAINTS. IT COULD BE "I WANT TO SEE THE DOCTOR. I WANT TO SEE THE DENTIST." SO THE TABLET SOLUTIONS HELP US SORT OUT BETWEEN "I WANT TO KNOW MY RELEASE DATE" AND "TERRI MCDONALD CALLED ME A BAD NAME." SO OF 44,000 INPUTS ON THAT, WE HAD 290 THAT WE CONSIDERED COMPLAINTS, OR LESS THAN 300. AND THEY VARY ANYTHING FROM A COMPLAINT AND ALLEGATION AGAINST AN EMPLOYEE OF SOMETHING SERIOUS TO "I KEEP TELLING YOU I NEED A MEDICAL APPOINTMENT AND YOU'RE NOT GIVING ME A MEDICAL APPOINTMENT." SO COMPLAINTS REALLY CAN VARY. THEY'RE MORE SERIOUS THAN A REQUEST FOR SERVICE. SO, IN OTHER WORDS, THEY'RE NOT SAYING EVERYTHING'S OKAY, I JUST NEED THIS. THEY'RE SAYING WE'RE SOMEHOW IN VIOLATION OF A POLICY OR THEY ARE RIGHT. EACH ONE OF THOSE GETS VETTED UP TO THE UNIT COMMANDER AND THEN I GET REPORTS BACK ON THEM, THE SEVERITY OF THEM IF THERE IS SOMETHING VERY SERIOUS. 

SUP. HILDA SOLIS: IT'S BEEN BROUGHT TO MY ATTENTION THAT THERE WERE AT LEAST 20 OF THOSE RELATED TO PERSONNEL COMPLAINTS. SO THERE'S HOPEFULLY SOME ACTION OR OVERVIEWS. 

ASST. SHERIFF MCDONALD: WE'RE LUCKY BECAUSE WE HAVE TWO DIFFERENT WAYS IN WHICH WE CAN LOOK AT COMPLAINTS. WE CAN LOOK AT THEM BY INMATE. WELL, WE LOOK AT THEM MULTIPLE WAYS. WE CAN LOOK AT THEM BY ISSUE. ARE THEY COMPLAINING ALL THE TIME ABOUT TIME CALCULATIONS? THAT'S A BIG COMPLAINT AREA, THAT OUR TIME CALCULATIONS ARE BAD. OR IS TERRI MCDONALD GETTING ALL THESE COMPLAINTS AGAINST HER. THAT P.P.I. WAS CHANGED A WHILE BACK TO ACTUALLY LET US SORT BY COMPLAINT. THERE ARE A VARIETY OF WAYS WE CAN DO IT. THE MORE WE CAN GET TO THIS TABLET SYSTEM, THE BETTER WE CAN GENERATE REPORTS THAN THE PAPER SYSTEM. AND I'M GLAD TO GET YOU INFORMATION ON WHAT THOSE CAME IN ON IF YOU GUYS ARE INTERESTED IN THEM. 

SUP. HILDA SOLIS: THE OTHER THING YOU MENTIONED, THE ROTATION, THE TRAINING FOR THE ROTATION, HOW IS THAT COMING ALONG? 

ASST. SHERIFF MCDONALD: IT'S COMING ALONG. THE JURY IS STILL OUT WITH ME. IT WAS DESIGNED TO BREAK DOWN DISRUPTIVE CLIQUES. IN OTHER WORDS, THE FIVE OF US JUST DIDN'T WORK TOGETHER AND WE JUST GOT MISGUIDED. IT WAS DESIGNED TO ROTATE US AROUND TO GET DIFFERENT EXPERIENCE. BUT THE PROBLEM IS IT ERODES WHAT YOU WOULD CONSIDER TO BE COMMUNITY POLICING WHERE I WORK A TIER. I KNOW WHO IS ON MY TIER. I RUN A GOOD TIER BY CONSTANTLY ROTATING PEOPLE AROUND. YOU'RE DEALING WITH A DISRUPTIVE CLIQUE PART OF IT BUT IT DESTABILIZES TIERS. I CONTINUE TO WATCH. THE GOOD NEWS IS WE DID NEGOTIATE BEING ABLE TO RESTRICT SOME HOUSING UNITS FROM THE CONSTANT SIX MONTHS ROTATION. A GOOD EXAMPLE BEING HIGH OBSERVATION HOUSING, THE ACUTE MENTALLY ILL. THAT TAKES A LOT OF TRAINING TO GET TO WORK IN THERE. IT TAKES A LONG TIME TO LEARN HOW TO INTERACT WITH MENTALLY ILL AND CHURNING PEOPLE AROUND HAS BEEN A CHALLENGE. SO WE'RE IN COMPLIANCE. WE'RE DOING WHAT'S BEEN ASKED OF US. BUT IT'S AN AREA THAT I CONTINUE NOT TO FEEL 100 PERCENT ABOUT. 

SUP. HILDA SOLIS: IN MY OTHER SET OF QUESTIONS ARE FOR THE INSPECTOR GENERAL AND JUST WANTING TO KNOW WHAT YOU THINK ARE THE MOST CRITICAL REMAINING ELEMENTS THAT YOU STILL THINK NEED TO BE IMPLEMENTED? 

MAX HUNTSMAN: AS I SAID BEFORE, I THINK THE MOST CRITICAL ONES ARE THE DEFERRED PHASE 3 ADDITIONAL STAFFING FOR IMPACT AND I.A.B. AND I.C.I.B. I THINK IN THE LONG TERM AND THAT'S OF THE THINGS THAT REMAIN TO BE IMPLEMENTED. CAMERAS, OF COURSE, ARE VERY CRITICAL AND SHOULD BE COMPLETED. THE BODY SCANNERS, OF COURSE, I THINK ARE CRITICAL. BUT THAT APPEARS TO HAVE MOTION ON IT AND IT APPEARS THAT THE BOARD IS WORKING ON DOING IT. THE OTHER STAFFING I THINK IS VERY IMPORTANT LONG-TERM. I UNDERSTAND WHY IT'S BEEN DEFERRED. I UNDERSTAND THE NEED TO RAMP UP ON ROSAS BECAUSE WE HAVE A FEDERAL CONSENT DECREE. BUT HOPE THE DEPARTMENT AND THE BOARD GO BACK TO IT LATER AND SEE THAT I.A. AND I.C.I.B. AND IMPACT ARE ROBUST ENOUGH THAT THEY CAN REALLY DO THEIR WORK WELL. IMPACT OF COURSE SEARCHING OUT PROBLEMS AND BEING ABLE TO IDENTIFY THEM. AND THEN I.A.B. AND I.C.I.B. AND DOING EFFECTIVE AND THOROUGH AND FAIR INVESTIGATIONS SO WE CAN HOPEFULLY KNOW FOR SURE WHAT'S HAPPENING. I THINK THOSE ARE THE MOST IMPORTANT. 

SUP. HILDA SOLIS: THANK YOU. 

SUP. ANTONOVICH, MAYOR: THANK YOU. WE HAVE PUBLIC COMMENT. 

ASST. SHERIFF MCDONALD: THANK YOU SO MUCH. 

SUP. ANTONOVICH, MAYOR: DR. GENEVIEVE CLAVREUL. RUTH SARNOFF. JOSEPH MAIZLISH. ROBERT LUCAS. JOSEPH IS NOT HERE. THEN ERIC PREVEN. 

DR. GENEVIEVE CLAVREUL: GOOD AFTERNOON, BOARD OF SUPERVISORS. DR. GENEVIEVE CLAVREUL. I WILL GIVE MY TIME TO ROBERT LUCAS. 

SUP. ANTONOVICH, MAYOR: OKAY. GIVE TIME TO MR. LUCAS. SET THE CLOCK. FOUR MINUTES. 

ROBERT LUCAS: GOOD AFTERNOON, EVERYBODY. 

SUP. ANTONOVICH, MAYOR: SHE GAVE HER TIME TO MR. LUCAS. 

ROBERT LUCAS:YOU KNOW, THERE'S A LOT OF THINGS THAT I KNOW HAVE CHANGED OVER TIME. IT SEEMS HOW SUCH FOCUS HAS BEEN BROUGHT ON SOME OF THE ISSUES IN THE COUNTY JAIL. SOME OF THE IMPLEMENTATIONS OF WHAT IS DEEMED TO BE ADDRESSING OF THE SOLUTIONS HERE, I'M NOT QUITE SURE THAT THE SHERIFF HAS FULLY GIVEN INFORMATION ABOUT SOME OF THE THINGS THAT GO ON. SHE SAID SOMETHING ABOUT STABILIZING A TIER AND ABOUT THE ROTATING OF STAFF. AND I CAN TELL YOU FROM MY OWN PERSONAL EXPERIENCE, THE ONLY THING THAT STABILIZES THE TIER IS THE WORKERS THAT, THE SHERIFFS THAT ARE RESPONSIBLE FOR THAT MOD OR THAT LETTERED TIER HAS OUT WORKING. IT CAUSES A LITTLE BIT OF A HIERARCHY WITHIN THE INMATES AS FAR AS PEOPLE GETTING A LITTLE BIT MORE FREEDOM. BECAUSE I KNOW THAT THESE TIERS, EVER SINCE THE '80S WHEN THE STATE MODULES WERE IMPLEMENTED BECAUSE OF THE INFORMATION THAT WAS COMING BACK FROM THE STATE PRISON SYSTEM AND THE CHAOS THAT WAS ENSUING FROM BASICALLY HIT SQUADS THAT CAME DOWN TO THE COUNTY DURING COURTS. THEY SEGREGATED THE JAIL AND SEPARATED THE PEOPLE COMING DOWN FROM THE STATE AND INTERACTING WITH THE COUNTY JAIL INMATES. THIS IS A TIME WHEN THEY COMPLETELY LOCKED DOWN THE FACILITY BECAUSE THERE WAS A LOT OF VIOLENT BAD THINGS GOING ON IN THE JAIL. WALKING TO THE DINING ROOM. THERE WERE ORCHESTRATED HITS, IF YOU WILL, ON SHERIFFS, ON OTHER INMATES, ON OTHER ASPECTS OF THE PRISON CULTURE AS FAR AS EARNING YOUR STRIPES AND SOME VERY INSIGNIFICANT ISSUES THAT EVOLVED INTO SOME VERY SERIOUS INCIDENTS. I KNOW THAT THIS TABLET CONCEPT, I CAN ONLY SPEAK FROM MY EXPERIENCE WITH INCIDENTS WITH THE SHERIFFS OVER TIME. IF I HAD AN INCIDENT WITH ONE OF THE CUSTODY, NO MATTER WHAT PART I PLAYED IN IT -- AND BELIEVE ME, I PLAYED A PART. IT WASN'T JUST RANDOMLY ATTACKING ME. IT'S NOT HOW IT WORKS. WHEN THERE'S AN INCIDENT WITH A DEPUTY SHERIFF, SOMEBODY IN CUSTODY, AND THESE TABLETS ARE TO BE MADE AVAILABLE IN ORDER TO REPORT THESE INCIDENTS, THESE ARE THE SAME SHERIFFS WHO WERE RESPONSIBLE IN GIVING THE FREEDOM TO THE INDIVIDUAL TO HAVE ACCESS TO THE TABLET. AND I KNOW FROM MY EXPERIENCE THAT WHENEVER THERE WAS AN INCIDENT WITH CUSTODY, I GOT PUT IN A SEGREGATED AREA IN THE HOLE BASICALLY FOR BEING DISRUPTIVE OR VIOLENT. BUT I HAD NO ACCESS TO ANYTHING. MY CONCERN WHEN SHE SAYS ABOUT THE SHERIFF SAID ABOUT THE PAPERWORK BEING IMPLEMENTED ON GRIEVANCES, IN THE JAIL LANGUAGE, A LOT OF THEM ARE REFERRED TO AS SNIVELING. UNLESS IT COMES TO AN INCIDENT WITH THE SHERIFF. MY CONCERN IS WHEN SHE SAID ALL OF THE NUMBERS OF GRIEVANCES THAT WERE PUT IN I KNOW THAT WE'VE BECOME TECHNOLOGICALLY EVOLVED TO WHERE THESE INCIDENTS WITH THE SHERIFFS COULD BE SEPARATED IMMEDIATELY INSTEAD OF INVESTING ALL THAT TIME IN SIFTING OUT FROM PEOPLE WITH MEDICAL ISSUES. ANOTHER, I WOULD HAVE LIKED TO HAVE PARTICIPATED IN THE ROLE PLAYING FOR THE MENTAL HEALTHS WITH THE SHERIFFS. I WOULD HAVE LOVED TO DO THAT. 

SUP. ANTONOVICH, MAYOR: LET ME CALL UP MR. PREVEN AND MR. SACHS. MISS SARNOFF. 

RUTH SARNOFF: I THINK THERE ARE A LOT OF PEOPLE THAT WOULD LIKE TO BE INCLUDED OR AT LEAST MORE KNOWLEDGEABLE ABOUT EXACTLY WHAT THE TRAINING IS AND LOOKS LIKE. I DON'T KNOW IF MEMBERS OF THE BOARD OF SUPERVISORS HAVE OBSERVED SOME OF THE TRAININGS. I HAVE A LOT OF QUESTIONS. I'M CONCERNED ABOUT THE ISSUE OF THE BODY SCANNERS AND HOW THEY WOULD BE USED IN REAL TIME AND WHO'S GOING TO VIEW ALL OF THIS? IS IT JUST BUILDING A VIDEO LIBRARY? I DON'T KNOW. THE OTHER QUESTIONS THAT I HAD AROUND THE NEW CATEGORIES HERE I DON'T KNOW EXACTLY HOW THAT DIFFERS FROM THE WAY YOU WERE DOING IT BEFORE, BUT I GUESS IT RELATES TO THE JUSTICE DEPARTMENT. AND I WAS ALSO INTERESTED IN SEEING THE -- I WAS SORRY TO SEE THAT I THINK IT WAS 9 AND 10 WERE PUT FORWARD BUT IN CASE I DON'T MAKE THE NEXT MEETINGS, I THINK THE FUNDING FOR THE MOVEMENT OF THIS PROCESS SHOULD BE VERY IMMEDIATE. I DON'T SEE PUTTING IT -- I DON'T THINK -- THERE'S NOTHING WRONG WITH WHAT MR. KNABE PROPOSED, BUT I THINK THAT THE FUNDING SHOULD BE IMMEDIATE AND I THINK THE CHANGES OUGHT TO BE NOTICEABLE AND SOME THOUGHT SHOULD BE TO IMPROVING THINGS LIKE FOOD AND LOWER THE NOISE LEVEL AND THINGS LIKE THAT IN REALTIME. THANK YOU. 

SUP. ANTONOVICH, MAYOR: THANK YOU. MR. PREVEN. 

ERIC PREVEN: YES, IT'S ERIC PREVEN, COUNTY RESIDENT FROM DISTRICT 3. AND I WILL NIBBLE, SIR. I DO NOT UNDERSTAND WHAT YOU MEAN BY THE A.C.L.U. NEEDS TO DISCLOSE HOW MUCH MONEY THAT THEY HAVE SPENT IN OVERSEEING THE JAILS AND SOMEHOW IT'S THEIR FAULT THAT THEY DIDN'T BRING TO YOUR ATTENTION THAT THESE PROBLEMS WERE GOING FORWARD. I WOULD LIKE TO SAY THAT THEY DID BRING IT FORWARD IN THE FORM OF SEVERAL LAWSUITS, FEDERAL CONSENT DECREES, A LOT OF STUFF CAME OUT BECAUSE OF THEIR WORK, IN FACT. I DON'T WANT TO GET INTO RIGHT NOW BUT I FOUND IT A LITTLE BIT INSULTING BECAUSE FOR SO LONG THERE WERE SO MANY CIVIL RIGHTS VIOLATIONS IN THIS SPACE. I WOULD ALSO NIBBLE ON TERRI MCDONALD'S COMMENT THAT APPARENTLY REICHERS AND COOK COUNTY TOGETHER DURING THE SAME PERIOD WHEN WE HAD ABOUT 700 USES OF FORCE, THEY HAD 6,200, I WOULD LIKE TO SEE THAT EVIDENCE BECAUSE THAT IS OBVIOUSLY YET ANOTHER EXAMPLE OF LET'S DEFINE OUR TERMS A CERTAIN WAY. THIS CHART WHICH CHANGED FROM 2011 TO 2012 IS VERY CONVENIENT. IT IS NOT CLEAR AT ALL TO AN ORDINARY READER AND I'M NOT JUST AN ORDINARY READER BECAUSE I LOOKED AT IT FOR A LONG TIME. IT'S CONFUSING. I WOULD ASK YOU, SIR, REGARDING THE 13 ADDITIONAL ITEMS FOR THE I.A.B. OR THE I.C.B., WHAT DOES THE BACKLOG CURRENTLY LOOK LIKE? THAT'S A REASONABLE QUESTION, I THINK. HAS IT BEEN REDUCED SUBSTANTIALLY? I WOULD HOPE SO. I CAN'T UNDERSTAND THAT. AND IT'S WORTH NOTING, SIR, THAT THE TIER STABILIZATION PIECE THAT MR. LUCAS TALKED ABOUT, I MEAN, YOU KNOW, LET'S JUST TALK BEING FOR A SECOND HOW WE STAFF UP THE JAIL AND TIE IT INTO THE SCANNERS BECAUSE I'M RUNNING OUT OF TIME. THE SCANNERS WHICH I'VE WITNESSED MYSELF, ARE EXTREMELY EXPENSIVE AND YOU GO THROUGH SIDEWAYS LIKE THIS. IT'S A LITTLE COMICAL. IT TAKES TIME AND STAFF. AND AT THE END OF THE DAY LET'S REMEMBER NORTHERN NEW YORK. THERE WAS A BAD PERSON WHO WORKED AT THE JAIL WHO WAS BRINGING STUFF IN. WE SHOULD GET DOGS IF WE'RE CONCERNED ABOUT DRUGS AND ORDINANCE AND STUFF, WEAPONS, WE SHOULD GET DOGS. THEY'RE CHEAPER, THEY WORK. THERE'S NO DOUBT. THE EMPLOYEES MIGHT NOT APPRECIATE IT IF THEY ARE BRINGING STUFF IN. BUT IF THEY ARE NOT BRINGING STUFF IN, THEY HAVE NOTHING TO WORRY ABOUT. WE ALL LOVE DOGS, INCLUDING, YOU, SIR, SOME OF THESE MATERIALS THAT HAVE BEEN REPORTED COULD BE REPORTED MORE CLEARLY BECAUSE I FIND IN LIGHT OF THE AUGUST FINDING WITH THE FEDERAL GOVERNMENT, THIS WHOLE PROCESS-- 

SUP. ANTONOVICH, MAYOR: THANK YOU. THANK YOU. MR. SACHS. 

ARNOLD SACHS: YES, THANK YOU. GOOD AFTERNOON. ARNOLD SACHS. A COUPLE THINGS. TALKING ABOUT CAMERAS FOR THE JAILS? THAT USED TO BE ON THE AGENDA FOR YEARS AND YEARS AND YEARS UNTIL GLORIA MOLINA TOOK IT OFF THE AGENDA. SO IT'S FINALLY COMING BACK FULL CIRCLE? HIRING OF PERSONNEL? THERE WAS A STORY IN THE NEWSPAPER A FEW MONTHS AGO THAT THE SHERIFF'S HAVING PROBLEMS FINDING ADEQUATE PERSONNEL. HOW'S THAT GOING? YOU'RE ALLOCATING FUNDING ALL THE TIME FOR MORE SHERIFFS. AND THE MENTIONING OF THE INCIDENT FORCES AT TWO PRISONS, DIDN'T THE COMMISSIONER FOR REICHERS, WASN'T HE A SPOKESPERSON? DIDN'T HE COME BEFORE THE COUNCIL, THE BOARD WHEN YOU HAD THE HEARINGS FOR THE JAIL HOUSE BLUE RIBBON COMMISSION? AND WASN'T HE-- DIDN'T HE WRITE SOME PAPERS, HE WAS THE PAST HEAD OF RIKERS ISLAND, DIDN'T HE WRITE PAPERS ABOUT HOW THEY CHANGED THE USE OF FORCE INCIDENTS AND THE PROGRAMS THEY INITIATED AT RIKERS ISLAND? I'M ALMOST POSITIVE THAT THE HEAD OF THE NEW YORK CITY PENAL SYSTEM WAS A PERSON WHO CAME BEFORE THE BOARD WITH RECOMMENDATIONS. AND DIDN'T THE BLUE RIBBON COMMISSION LOOK AT THE STATISTICS FROM RIKERS ISLAND AND COOK COUNTY JAIL IN DISCUSSING SOME OF THE CHANGES THEY WERE TALKING ABOUT MAKING THROUGH THE RECOMMENDATIONS THAT THEY FINALLY CAME UP WITH? SO THAT ALSO COMING FULL CIRCLE IS NOW THE COUNTY OF L.A. IS BEING LEFT BY THESE TWO PRISONS OR COMMUNITIES THAT THEY LOOKED AT FOR RECOMMENDATIONS TO CLEAN UP THE CITY -- THE COUNTY. SOMETHING JUST DOESN'T MAKE SENSE. 

SUP. ANTONOVICH, MAYOR: OKAY. MOTION TO RECEIVE AND FILE. WITHOUT OBJECTION, SO ORDERED. ITEM NO. 8, THIS IS GOING TO BE CONTINUED BUT I JUST WANTED THESE QUESTIONS TO BE ANSWERED NEXT WEEK. THE SOURCE OF THOSE $300,000 AND WASN'T IT NOT INCLUDED IN THE 2015/'16 BUDGET AS A LINE ITEM? AND HOW DID THE OTHER JURISDICTIONS PAY? BECAUSE WE KNOW WITH L.A.-RICS, THE OTHER JURISDICTIONS WERE SUPPOSED TO PAY AND ENDED UP NOT PAYING. WILL THE PRODUCT WORK COME BACK BEFORE THE BOARD FOR APPROVAL? DOES THE ACTION DELEGATE FURTHER COMMUNITY CHOICE AGGREGATION DECISIONS TO WORK FOR THE GROUP IN THE PROCESS FOR NEXT WEEK. 

SUP. KUEHL: DO YOU WANT THOSE QUESTIONS ANSWERED TODAY, MR. MAYOR? OF SIMPLY WANTED TO CONTINUE AND PROPOSE THE QUESTIONS THAT NEED TO BE ANSWERED NEXT TIME? 

SUP. ANTONOVICH, MAYOR: RIGHT. 

SUP. KUEL: THANK YOU VERY MUCH. 

SUP. ANTONOVICH, MAYOR: WE HAD ROBERT LUCAS HAD SIGNED UP ON IT, THAT'S WHY. 

SUP. KUEHL: SO WE CONTINUED ITEM 8? 

SUP. ANTONOVICH, MAYOR: AFTER MR. LUCAS. 

ROBERT LUCAS: WHEN THE SUPERVISORS GOT TOGETHER AND CAME UP WITH THIS, IT'S AMAZING THAT ALL OF THE COMMISSION'S RESPONSIBILITIES REALLY COVER A LOT OF THE QUESTIONS THAT I HAD. NOT THAT I'M ANY CREDENCE OTHER THAN MY OWN EXPERIENCE GOING THROUGH THERE. I ALWAYS KNEW THAT SOME OF THE ANSWERS LIED IN THE SENTENCING, THE LAWS. AND WITH THE DIVERSION COMING AFTER THE FACT, SOME OF THE EMPLOYEES THAT WILL BE IN CHARGE OF QUALIFYING SOME OF THE INMATES FOR THIS DIVERSION IS A VERY SENSITIVE POSITION. I WENT AROUND TO LYNWOOD, EAST L.A. SOME OF THE SHERIFF'S DIVISIONS OUT IN THE VALLEY. IN TRYING TO, AS A CITIZEN, INDEPENDENTLY OPENING UP SOME COMMUNICATION ON THIS COMMISSION FOR THE JAIL VIOLENCE. NOW I NEVER USED THAT TERM OR LABEL, BUT JUST AS A CONCERNED INDIVIDUAL, AND IT DIDN'T GO SO WELL. NOW, I REALIZE I DON'T HAVE THE CREDENCE OR THE COMMISSION TITLE OR LABEL WHEN YOU WALK INTO A SHERIFF'S DEPARTMENT; HOWEVER, I KNOW THAT IN SOME INSTANCES I WAS JUST INQUIRING ABOUT BASIC THINGS. AND IT WAS REALLY QUITE COLD SHOULDERED. 

SUP. ANTONOVICH, MAYOR: YOU DIDN'T HAVE THE WARM RECEPTION THAT YOU HAD FROM THE FIVE OF US HERE EACH TUESDAY? 

ROBERT LUCAS: THAT'S MORE TRUTH THAN YOU CAN REALIZE. 

SUP. ANTONOVICH, MAYOR: WE'LL CONTINUE THAT ITEM UNTIL NEXT WEEK. OKAY. THANK YOU. ON ITEM 43, I HAD HELD THAT JUST TO AMEND THAT WE SHOULD ALSO SEND COMPARABLE LETTERS TO THE NEW MINORITY LEADERS IN BOTH THE HOUSE AND THE SENATE WHO ALSO SELECTED. SO WE'RE GOING TO HAVE THREE NEW LEADERS IN THE COMING 2016 SESSION OF THE LEGISLATURE. AND TWO OF THOSE OR THREE FROM SOUTHERN CALIFORNIA. OKAY. SO SUPERVISOR SOLIS WILL MOVE THE MOTION, I'LL SECOND AS AMENDED. WITHOUT OBJECTION, SO ORDERED. AND THEN SUPERVISOR KUEHL -- OR LET ME CALL UP MR. PREVEN FOR 2-P, 3, 5, 15, IS IT 19? 22, 25, 29, 36. MR. LUCAS ON 2-P. DAVID DELONG ON 13. AND DR. CLAVREUL ON 1, 24, 25. 

ERIC PREVEN: YES, IT IS ERIC PREVEN COUNTY RESIDENT FROM DISTRICT 3. AND ITEM 25, FIRST LET ME JUST SAY THAT I THINK SOMEONE IN THE FUTURE, IF SOMEONE IS SPEAKING ON THE WRONG ITEM, MR. LUCAS I THINK WAS TALKING ABOUT ITEM 9 EVEN THOUGH HE WAS CALLED UP ON ITEM 8. SOMEBODY SHOULD TRY TO GUIDE THEM BECAUSE WE DO TAKE THE TIME TO MAKE THE COMMENT. I DON'T THINK IT WAS INTENTIONAL BUT IT WOULD BE HELPFUL. ITEM 25 I'D LIKE TO THANK LAURA ZUCKER AND DR. KATZ WHO ARE MAKING AVAILABLE SOME ART FROM A HUNGARIAN ARTIST FOR THE HOSPITAL DOWN IN -- WHICH IS VERY NICE. AND IT WILL HEAL AND HOPEFULLY INSPIRE AND I THINK THIS IS ALWAYS GOOD TO IDENTIFY PEOPLE WHO ARE BEING GENEROUS. AND THANK YOU FOR THAT. IT'S THE PEEL FAMILY WHO DONATED THE ART. SO THAT'S VERY NICE. AND I WOULD ALSO SAY THAT ALTHOUGH I'M ALWAYS PAYING CAREFUL ATTENTION TO THE JOHN ANSON FORD, ITEM 2-P, SUPERVISOR KUEHL, IS YET ANOTHER LOAD OF 500 AND SOMETHING THOUSAND DOLLARS OF EXCESS FUNDS FROM THE 1996 MONEY THAT YOU ARE POURING INTO THAT. SO NOW HERE IT DOES SAY FOR THE FIRST TIME IN A WHILE THAT THERE IS AN OFFICE BUILDING INVOLVED. SO THAT'S ENCOURAGING. AT LEAST WE'RE COMING FORWARD WITH SOME TRICKY LIKE SUBSTANCE. MY CONCERN IS THAT ONCE AGAIN THIRD DISTRICT DOES HAVE, CONTRARY TO POPULAR BELIEF, SUBSTANTIAL NEEDS IN PARKS AND REC. WE HAVE A BIG GROUP LOOKING AT THAT. WE HAVE $2 MILLION EARMARKED FOR ADMINISTRATIVE. PLEASE. THERE ARE PLACES LIKE, FOR EXAMPLE, THE SAN FERNANDO POOL, I WILL RAISE IT FOR THE THIRD TIME. SAN FERNANDO HAS A POOL, IT'S RUN BY THE CITY, THEY CAN'T AFFORD IT. MR. YAROSLAVSKY GAVE THEM A MILLION BUCKS. I THOUGHT IT WAS ONE TIME. LET'S CHECK IF IT WITH MISS WICKHAM IF IT WAS ONE TIME OR IF IT'S ONGOING BECAUSE THAT SOLVES A LOT OF PEOPLE'S PROBLEMS IN THAT AREA. ITEM NO. 20 IS AN INCREASE IN SALARY RANGE FROM R12 TO R14 FOR ONE SET AND FROM R17 TO R18 FOR THE CHIEF DEPUTY OF D.C.F.S. THIS IS A BIG JOB. OBVIOUSLY WE'RE TALKING ABOUT THOUSANDS OF EMPLOYEES, CLEARLY WHATEVER THAT RANGE IS SHOULD BE A SUBSTANTIAL RANGE. I'VE ASKED THIS BOARD OF SUPERVISORS TO MAKE CLEAR WHAT IS THE RANGE? I'M NOT SCROLLED INTO THIS PERSONNEL FILES. IF IT WERE ON THE AGENDA, WE COULD SEE WHAT THAT RANGE IS AND THEN WE WOULD KNOW. THAT WOULD BE VERY, VERY HELPFUL. ITEM NO. 3 I THINK WE COULD THANK TOTAL TRANSPORTATION ASSOCIATES T.T.S.I. THEY LOBBY THROUGH ENGLANDER KNABE AND ALLEN. SUPERVISOR KUEHL IS ASKING FOR VEHICLE FUEL PROCUREMENT AND MANAGEMENT NUMBERS. WE WOULD LIKE TO LOOK AT THAT. ALSO ASK ABOUT THE FLEET OF EACH OF THE DEPARTMENTS. BECAUSE THE FLEET IS ENORMOUS. AND WE NEED TO TRIM BACK WHERE WE CAN. ITEM NO. 5, 6 AND 7 ARE ALL HIGH HOLY DAYS GRANTS OF PARKING FOR SUPERVISOR KUEHL HAS MADE FOR DIFFERENT CONGREGATIONS. TASTEFULLY I THINK ONE PER SEASON IS APPROPRIATE. THAT'S WHAT YAROSLAVSKY ALWAYS DID. BUT IF YOU'RE GOING TO DO MULTIPLE THEN YOU SHOULD THINK ABOUT OTHER RELIGIONS THAT ALSO CELEBRATE. ITEM NO. 15 IS SUPERVISOR SOLIS DOES A VERY GOOD JOB OF EARMARKING THE EXACT EXPENDITURES OF $2,753 THAT I THINK IT'S I.S.D.'S PICNIC OR SOMEBODY'S PICNIC. WHEN THIS MALIBU TRIATHLON CAME THROUGH, WE DIDN'T HAVE SUCH ITEMIZATION. I ASKED FOR IT. I WOULD ASK THE AUDITOR CONTROLLER, OR MARY WICKHAM LOOKS VERY BUSY BUT SOMEBODY TO LOOK INTO THAT BECAUSE IT IS IMPORTANT. 

SUP. ANTONOVICH, MAYOR: THANK YOU. ARNOLD SACHS? ARNOLD SACHS. DR. CLAVREUL. 

DR. GENEVIEVE CLAVREUL: GOOD AFTERNOON, BOARD OF SUPERVISORS, DR. GENEVIEVE CLAVREUL. ON ITEM 1 WITH THE NUMEROUS INDIVIDUALS WHO HOPE TO BECOME COMMISSIONER OF H.I.V. AND AIDS, AND YOU KNOW I HAVE HAD THAT SAME STATEMENT ALL THE TIME THAT SOME OF THE INDIVIDUALS WILL NEED TO BE COMMISSIONERS MUST BE NOT PROVIDING CARE ON H.I.V. OR HAVING H.I.V. AND AGAIN ALL INDIVIDUALS TODAY WHO ARE FULL COMMISSIONERS ARE PROVIDING CARE FOR PEOPLE FOR H.I.V. OSHA IS VERY STRICT ABOUT THAT AND WANTED PROPORTIONS OF INDIVIDUALS WHO ARE NOT PROVIDING CARE OR RECEIVING CARE. YOU HAVE DONE THAT FOREVER. BUT I GUESS, YOU KNOW, I'M JUST SAYING IT FOR THE RECORD. ON ITEM 24, HAVING TO DO THE CAFETERIA SERVICE AT THE HIGH DESERT, I AM NOT SPECIFICALLY TALKING ON THAT ITEM BECAUSE I WANT TO BRING AGAIN TO THIS WONDERFUL GROUP HERE THAT WE ARE HAVING SOME PUBLIC COVENING FOR THE SO-CALLED HEALTHCARE AGENCIES. AGAIN, WE ARE GIVING FIVE DATES. ALL OF THEM IN THE DAYTIME ALMOST. ALL OF THEM WE HAVE FIVE CONVENING FOR A COUNTY OF 10 MILLION PEOPLE. THAT'S A JOKE. AND OF THE TIME BEING GIVEN, VERY FEW PEOPLE COULD ATTEND. IT'S OBVIOUS THAT DR. KATZ AND ALL OF HIS GOONS DON'T WANT NOBODY TO ATTEND BECAUSE THE TIME THOSE MEETINGS ARE LIKE FROM 10 TO 12, 1 TO 3. 9:30 TO 11. SO IF YOU ARE WORKING, YOU CANNOT ATTEND ANY OF THOSE MEETINGS. I THINK IT'S PRETTY SAD. I THINK THE CHANGE WE ARE MAKING ABOUT THOSE THREE AGENCIES DEMAND PUBLIC HEARINGS. NOT SO-CALLED FAST CONVENINGS. AND FROM THE BEGINNING, IT HAS BEEN PUSHED DOWN OUR THROAT. IN AUGUST 11 YOU VIOLATED THE BROWN ACT IN BRINGING THAT TO THE TABLE. I DEMAND THAT YOU CURE AND CORRECT AND REMOVE THAT ITEM UNTIL IT IS DONE APPROPRIATELY. THANK YOU. 

SUP. ANTONOVICH, MAYOR: THANK YOU. MR. SACHS? 

ARNOLD SACHS: I DID HOLD SEVERAL ITEMS. I HELD 1-P. AND 1-P REFERS TO CITY EXCESS FUNDS FOR PROP A FOR THE COMPTON CREEK WALKING PATH. AND THEN FURTHER ON IN YOUR AGENDA, ON ITEM 23, PROP A TO PROVIDE SERVICES FOR THE PUBLIC HEALTH FACILITIES FUNDING. SO I WAS WONDERING. THAT'S QUITE A MENU OF FUNDING USES FOR PROP A. IS IT THE SAME PROP A THAT WOULD BE USED FOR THE COMPTON CREEK WALKING PATH AND TO PROVIDE PUBLIC HEALTH SERVICES? PROVIDE SERVICES AT PUBLIC HEALTH FACILITIES? I HELD ITEM 2-P, AS YOU REMEMBER LAST WEEK, MISS KUEHL, WE TALKED A LITTLE ABOUT USE OF FUNDING, COUNTY FUNDING. AT $23 A PARCEL, THAT'S 20,000 PARCELS TO FUND THIS WORK AT JOHN ANSON FORD THEATER. AGAIN, I SAY THE CITY HAS A CONTRACT WITH TICKET PROMOTERS FOR THE GREEK THEATER. WHY ARE WE SPENDING $550,000, WHY ISN'T THE COUNTY LOOKING INTO DOING AN R.F.P. FOR A TICKET PROMOTER TO TAKE OVER THIS AND DO THE WORK ITSELF? AND THEN IN ADDITION, THERE'S A PROCEDURAL GUIDE. IS IT ONE GUIDE PER SPECIFIED PER PARCEL IN EXCESS FUNDS? OR IS IT THREE DIFFERENT GUIDES FOR EACH ONE OF THOSE CATEGORIES OF FUNDING? I HELD ITEM 21 AND 41. THAT'S ONE OF THOSE RECLASSIFICATION DEALS. 26 DEPARTMENTS. ORDINANCE POSITIONS. DOES THAT INCLUDE WHEN MR. BROWNING TESTIFIED BEFORE THE BOARD A COUPLE YEARS AGO, HE MENTIONED THE BOARD POLICY OF KEEPING 10 PERCENT OF THE POSITIONS IN THE DEPARTMENT OPEN. DOES THAT -- IS THAT POLICY STILL IN EFFECT? AND AGAIN IT COMES BACK TO THE 26 DEPARTMENTS LISTED, ONE OF THEM INCLUDES THE BOARD OF SUPERVISORS. AND I'M THINKING TO MYSELF WHEN YOU ANNOUNCED YOUR INTERIM C.E.O., YOU MENTIONED IT WAS UNFAIR TO CHOOSE A DEPARTMENT HEAD BECAUSE IT GAVE THEM AN UNFAIR ADVANTAGE. AND YET YOU PUT A DEPARTMENT HEAD, ACCORDING TO YOUR AGENDA, AS THE HEAD OF THE C.E.O. BECAUSE IT SAYS HERE ONE OF THE RECLASSIFICATIONS OCCURRING IS IN THE BOARD OF SUPERVISORS. IT'S A DEPARTMENT. AND SACHI WAS A DEPARTMENT HEAD WHEN SHE WAS SITTING ON THE OTHER SIDE OF HER SEAT. SO HOW'S THAT WORK? IT'S WHATEVER WE SAY. I HELD ITEMS 26 AND 31 BECAUSE IT DEALS WITH SOME STAFFING. AND I'M THINKING ABOUT THE $15 LABOR INCREASE. SO THIS LANDSCAPING, IF IT'S AN UNINCORPORATED AREA, DO THEY GET $15? AND IF IT'S NOT IN AN UNINCORPORATED AREA, DO THEY GET THE LIVING WAGE PREVAILED? AND THEN OVERSIGHT OF BOARD MEETINGS. SO YOU MENTIONED SOMETHING ABOUT KNOWING THE LAW, MISS KUEHL. 

SUP. ANTONOVICH, MAYOR: THANK YOU. SUPERVISOR SOLIS WILL MOVE AND I'LL SECOND. WE'LL APPROVE THOSE ITEMS. 

AVIANNA URIBE, ACTING ASS'T EXEC. OFCR.: ITEMS 1-P, 2-P, 1, 3, 5, 13, 15, 18, 21, 22, 25, 36, 41, 42 AND ON ITEMS NO. 2, 19, 24 AND 29, SUPERVISOR ANTONOVICH REQUESTS THESE BE CONTINUED ONE WEEK TO SEPTEMBER 15TH. THOSE ITEMS ARE BEFORE YOU. 

SUP. ANTONOVICH, MAYOR: SUPERVISOR SOLIS MOVES. SECOND. WITHOUT OBJECTION, SO ORDERED. ADJOURNMENT MOTIONS? SUPERVISOR KUEHL? 

SUP. SHEILA KUEHL: THANK YOU VERY MUCH, MR. MAYOR. I MOVE THAT WHEN WE ADJOURN TODAY, WE ADJOURN IN MEMORY OF MARTIN MILNER, VETERAN ACTOR, TELEVISION STAGE AND FILM RECENTLY PASSED AWAY AT THE AGE OF 83. HE LIVED FINALLY IN CARLSBAD AND SUFFERED A LONG ILLNESS. HE WAS BORN IN DETROIT TO A MOTHER WHO WAS A DANCER, FATHER WHO WAS A CONSTRUCTION WORKER. MOVED TO SEATTLE AND BEGAN ACTING IN A LOCAL THEATER GROUP AS A CHILD BEFORE MOVING TO LOS ANGELES AS A TEENAGER HE APPEARED IN HIS FIRST MOVIE AT THE AGE OF 15, "LIFE WITH FATHER" WITH WILLIAM POWELL. HE CONTINUED HIS ACTING CAREER ON A SHOW WITH WHICH I'M VERY FAMILIAR, "THE STU IRWIN SHOW." IT WAS THE FIRST SERIES THAT I DID AT HAL ROACH STUDIOS IN '50 TO '56 AND MARTY MILNER PLAYED MY OLDER SISTER'S BOYFRIEND THE WHOLE SIX YEARS. I WAS OF COURSE JUST A KID SO IT'S HARD TO SAY WE WERE GOOD FRIENDS SINCE HE WAS A GROWNUP, BUT WE KEPT IN TOUCH FOR QUITE A LONG TIME BECAUSE AFTER HE BECAME FRIENDS WITH ACTOR JACK WEBB AND BEGAN APPEARING IN THE ORIGINAL RADIO VERSION OF "DRAGNET," IT CARRIED ON TO ONE OF HIS GREATEST SUCCESSES, WHICH WAS JACK WEBB'S LATE '60S TV SERIES "ADAM 12". OF COURSE PEOPLE ALREADY KNEW MARTY MILLER BECAUSE OF HIS FIRST MAJOR TELEVISION SUCCESS COSTARRING IN "ROUTE 66" WHERE HE BECAME KNOWN AS THE GUY WITH THE CORVETTE. AND IN ADDITION TO HIS OWN SERIES, HE APPEARED IN A LOT OF TV PROGRAMS, SOME FILMS AND ON STAGE. HE IS SURVIVED BY HIS WIFE OF 58 YEARS, JUDY, TWO SONS, STEWART AND ANDREW, AND A DAUGHTER MOLLY AND THREE GRANDCHILDREN. HIS DAUGHTER AMY PREDECEASED HIM IN 2004. AND I ALSO MOVE THAT WHEN WE ADJOURN TODAY, WE ADJOURN IN MEMORY OF DICK GULDSTRAND, LONG- TIME RESIDENT OF THE THIRD DISTRICT AND A LEGENDARY AUTO RACER AND CUSTOM CAR BUILDER, DESIGNER AND MECHANIC KNOWN AS MR. CORVETTE. RECENTLY PASSED AWAY AT THE AGE OF 87 IN HIS NORTH HOLLYWOOD HOME. BORN IN L.A. TO AN ENGINEER FATHER AND A MOTHER WHO PERFORMED IN VAUDEVILLE, HE WAS A NATURALLY TALENTED EXTROVERT AND A DEDICATED HOT RODDER. HE WENT ON TO STUDY ELECTRICAL ENGINEERING AT U.C.L.A. WORKED FOR A TIME FOLLOWING MILITARY SERVICE AT AN AERONAUGHTICS FIRM, BUT HIS HEART ALWAYS REMAINED IN THE RACING WORLD. AND IN THE EARLY 1960S HE PURSUED RACING FULL-TIME EVENTUALLY WINNING THREE CONSECUTIVE SPORTS CAR CLUB OF AMERICA PACIFIC COAST CHAMPIONSHIPS, SETTING A LE MANS TRACK RECORD AND FINISHING FIRST IN HIS CLASS AT THE DAYTONA 24-HOUR RACE. HE OPENED GULDSTRAND ENGINEERING IN CULVER CITY IN 1968, CONCENTRATING ON CUSTOM CORVETTES WHERE HIS CELEBRITY CLIENTELE INCLUDED JIM GARNER, BRUCE SPRINGSTEIN, NICHOLAS CAGE AND MY VERY GOOD FRIEND ARNOLD SCHWARZENEGGER. IN 1999 HE WAS INDUCTED INTO THE CORVETTE HALL OF FAME AT THE NATIONAL CORVETTE MUSEUM IN BOWLING GREEN, KENTUCKY. RELOCATED HIS AUTO SHOP TO BURBANK, CONTINUED TO WORK ON CORVETTES AND OTHER HIGH PERFORMANCE CARS VIRTUALLY UNTIL THE DAY OF HIS DEATH. HE'S SURVIVED BY HIS WIFE OF 41 YEARS, WILLY, TWO CHILDREN FROM A PREVIOUS MARRIAGE, GARY AND GAY, A STEPSON VICTOR NELLI, A BROTHER BOB, AND SIX GRANDCHILDREN. THANK YOU, MR. MAYOR. 

SUP ANTONOVICH, MAYOR: SECOND. WITHOUT OBJECTION, SO ORDERED. LET ME ALSO MOVE THAT WE ADJOURN IN MEMORY OF A GOOD FAMILY FRIEND, JANET J.C. PENG, PASSED AWAY ON SEPTEMBER 2ND AT THE AGE OF 98. SHE WAS QUITE ACTIVE IN MANDARIN BAPTIST CHURCH IN ALHAMBRA. SURVIVED BY HER FOUR DAUGHTERS AND HER GRANDCHILDREN. SHE WAS A WONDERFUL LADY, WONDERFUL FRIEND AND DEVOTED TO HER COMMUNITY AND HER FAMILY. DEAN JONES, THE STAR FROM THE '60S AND '70S PASSED AWAY AT THE AGE OF 84. SERVED IN THE UNITED STATES NAVY DURING THE KOREAN CONFLICT AND WAS IN MANY MOTION PICTURES AND ALSO ON BROADWAY WHERE HE STARTED WITH JANE FONDA AND IN THE '63 JACK LEMON FILM "UNDER THE YUM YUM TREE." . HIS GREATEST SUCCESS AS A DISNEY PLAYER STARTING WITH "THAT DARN CAT" INCLUDING "THE UGLY DACHSHUND", "MONKEYS GO HOME" AND "THE HORSE IN THE GRAY FLANNEL SUIT", "THE SHAGGY D.A." AND "HERBIE THE LOVE BUG." HE LATER FOUNDED THE CHRISTIAN RESCUE MISSION COMMITTEE AND NOW KNOWN AS THE CHRISTIAN RESCUE FUND. SURVIVED BY HIS WIFE AMD THREE CHILDREN. HE WAS A FRIEND AND ONE OF MY SUPPORTERS. BEN KUROKI, VETERAN OF WORLD WAR II PASSED AWAY AT THE AGE OF 98. HE HAD ENLISTED IN THE UNITED STATES ARMY FOLLOWING THE ATTACK ON PEARL HARBOR. AT THAT TIME THE UNITED STATES ARMY HAD BANNED SOLDIERS OF JAPANESE DECENT FROM BOMBER CREWS, HOWEVER HE MANAGED TO SECURE A POSITION AS TAIL GUNNER IN THE 93RD BOMB GROUP. HE SERVED IN DOZENS OF MISSIONS IN EUROPE AND NORTH AFRICA AND WAS AWARDED THE DISTINGUISHED FLYING CROSS. HE THEN REQUESTED REASSIGNMENT TO THE PACIFIC THEATER WHERE HE SERVED UNTIL THE END OF THE WAR. HE LATER WORKED AS A NEWSPAPER MAN FOLLOWING HIS DISCHARGE AND RETIRED AS THE EDITOR OF THE VENTURA STAR FREE PRESS AFTER THREE DECADES CAREER IN JOURNALISM. HE WAS A SUBJECT OF THE 2007 P.B.S. DOCUMENTARY "MOST HONORABLE SON" WHICH HIGHLIGHTED HIS EXTRAORDINARY SERVICE TO THE UNITED STATES. HE WAS SURVIVED BY HIS WIFE, SISTER, THREE DAUGHTERS AND FOUR GRANDCHILDREN. REVEREND WILLIE DOUGLAS PASSED AWAY AT THE AGE OF 64. HE WAS A LEADER OF THE N.A.A.C.P. AND WAS STOCKTON'S BRANCH PRESIDENT FROM 2001 TO 2003. HE HELPED FOUND THE N.A.A.C.P. STOCKTON YOUTH COUNCIL, THE BIG BROTHERS BIG SISTERS OF SAN JOAQUIN COUNTY, CALIFORNIA BLACK LEAGUE OF VOTERS, THE SAN JOAQUIN COUNTY EMPLOYEES' COOPERATIVE AGAINST RACIAL DISCRIMINATION AND THE CALIFORNIA BLACK BROWN SUMMIT ON RE-ENTRY AND RECIDIVISM. HE WAS RECOGNIZED WITH THE 2015 HUMANITARIAN AWARD AND HONORED WITH A LIFETIME HUMANITARIAN ACHIEVEMENT FROM THE AFRICAN-AMERICAN CHAMBER OF COMMERCE AND FOUNDATION OF SAN JOAQUIN. HE'S SURVIVED BY HIS WIFE KAREN AND THREE CHILDREN. HE SERVED WITH MY COMMISSIONER ON THE STATE BOARD AND JUST TRAGICALLY PASSED AWAY AT THEIR LAST MEETING. JAMES HAWKINS, ONE OF THE GREAT GENEROUS SUPPORTERS OF THE BOY SCOUTS FOR MANY YEARS, LEADER OF THE QUEST BEHIND EAGLE HIGH ADVENTURE PROGRAM WITH THE SCOUTS. SURVIVED BY HIS WIFE HELENE, THEIR 10 CHILDREN, 16 GRANDCHILDREN AND 4 GREAT GRANDCHILDREN. -- RETIRED SERGEANT FROM THE LOS ANGELES COUNTY -- SERGEANT VEDA HALL, RETIRED SERGEANT FROM THE L.A. COUNTY SHERIFF'S DEPARTMENT. JOINED THE DEPARTMENT IN '72 AND RETIRED FROM THE CORRECTIONAL FACILITY IN 1992. CHARLES VALLEE MORAN, LONGTIME RESIDENT OF SAN MARINO, PASSED AWAY AT 97, WAS THE CO-FOUNDER OWNER OF MORAN MOTORS WHERE HE WORKED IN THE AUTOMOBILE BUSINESS FOR 61 YEARS. SURVIVED BY HIS WIFE, THEIR THREE SONS AND GRANDCHILDREN. CECELIA HOSCHET, TRAGICALLY KILLED YESTERDAY AT THE AGE OF 32. SHE WAS A TWO-YEAR VETERAN OF THE LOS ANGELES COUNTY SHERIFF'S DEPARTMENT. WORKED AT THE INMATE RECEPTION CENTER. SHE IS SURVIVED BY HER SIX-YEAR-OLD SON. WOODROW WILSON MEIER, AT THE AGE OF 96 HE PASSED AWAY ON AUGUST 22ND. HIS DOCTORATE IN MEDICINE CAME FROM THE UNIVERSITY OF NEBRASKA WHERE HE SERVED IN THE UNITED STATES NAVY. HE OPENED THE 24/7 EAST LOS ANGELES EMERGENCY CLINIC. WAS ALSO ON THE MEDICAL STAFF AND BOARD OF BEVERLY HOSPITAL FOR OVER 50 YEARS, ACTIVE IN GRACE PRESBYTERIAN CHURCH, SURVIVED BY HIS THREE DAUGHTERS, BROTHER AND GRANDCHILDREN AND GREAT GRANDCHILDREN. JOHN VON KANNON PASSED AWAY ON SEPTEMBER 5TH. HE WAS VICE PRESIDENT, SENIOR COUNSELOR OF THE HIERITAGE FOUNDATION, ELECTED AS DISTINGUISHED MEMBER OF THE PHILADELPHIA SOCIETY WHERE HE SERVED TWO TERMS AS TRUSTEE. HE IS SURVIVED BY HIS WIFE CINDY AND THEIR TWO CHILDREN. HENRY MERKLE, LONG TIME RESIDENT OF THE ANTELOPE VALLEY. MARINE CORPS VETERAN AND SERVED AS A TEACHER AT PALMDALE HIGH SCHOOL AND ANTELOPE VALLEY COMMUNITY COLLEGE FOR 30 YEARS. AFTER RETIRING, HE THEN BECAME INVOLVED IN THE FOOTHILL COMMUNITY VOLUNTEERING AT THE PASADENA SENIOR CENTER AND AT GLENDALE COMMUNITY COLLEGE. SURVIVED BY HIS WIFE, SONS, STEPDAUGHTER. SECONDED BY SUPERVISOR KUEHL WITHOUT OBJECTION, SO ORDERED. 

SUP. SHEILA KUEHL: I'M SORRY. 

SUP. HILDA SOLIS: I HAVE ONE. 

SUP. SHEILA KUEHL: I THINK ALL THE MEMBERS WOULD PROBABLY WANT TO JOIN IN IN ADJOURNMENT. I DON'T KNOW WHAT THE PRECEDENT IS FOR THE DEPUTY. 

SUP. ANTONOVICH, MAYOR: ALL MEMBERS, OKAY. SUPERVISOR SOLIS? 

SUP. HILDA SOLIS: I DID HAVE ONE ADJOURNMENT THANK YOU, MR. MAYOR. I MOVE THAT TODAY WE ADJOURN IN MEMORY OF CAPTAIN GARY A. WALKER WHO WAS BORN ON NOVEMBER 16, 1947 IN OKLAHOMA, PASSED AWAY ON AUGUST 27, 2015 AT THE AGE OF 68. HE SERVED OUR COUNTRY AS THE UNITED STATES MARINE FROM 1970 THROUGH '76 AND AT THE AGE OF 50, CAPTAIN WALKER RETURNED TO COLLEGE TO COMPLETE HIS BACHELOR OF ARTS DEGREE WHICH ENABLED HIM TO FURTHER HIS CAREER AS A POLICE OFFICER. HE RETIRED AS A POLICE CAPTAIN AT THE EL MONTE POLICE DEPARTMENT AND SERVED THERE FOR 35 YEARS. ALSO AS A HEARING OFFICER FOR L.A. COUNTY DISTRICT ATTORNEY'S OFFICE IN 2015 WITH 10 YEARS OF SERVICE. HE WAS KNOWN FOR HIS LEADERSHIP AND STRONG WORK ETHIC, RECEIVED MANY ACCOLADES THROUGHOUT HIS CAREER. HE MARRIED CHERYL BRIERLEY ON MAY 7, 1976. THEY ENJOYED MAKING PLANS FOR FAMILY VACATIONS AND PARTICIPATING IN EVERY ASPECT OF THEIR GIRLS' LIVES. CAPTAIN WALKER IS SURVIVED BY HIS WIFE OF 39 YEARS, CHERYL, DAUGHTERS VALERIE, SHILOH, DESIREE AND GRANDCHILDREN COREY WALKER DAYTON MCKENNA, STEPHANIE, NATHAN AND NOLAN AND A HOST OF EXTENDED FAMILY MEMBERS. 

SUP. ANTONOVICH, MAYOR: SECOND WITHOUT OBJECTION, SO ORDERED. OKAY. PUBLIC COMMENT. OSCAR MOHAMMED. ROBERT LUCAS. RUTH SARNOFF. CHIKODILI ODENGWU. MR. MOHAMMED. 

OSCAR MOHAMMED: OH, YES. MY NAME IS OSCAR MOHAMMED. I SPEAK FOR THE OPPRESSED AND I SPEAK FOR THE STRUGGLING POOR AND I SPEAK FOR CULTURE CHANGE. WE'D LIKE TO END POLICE BRUTALITY. WE SHOULD FIND A WAY TO STRUCTURE THE POLICE DEPARTMENT AND THE SHIERFFI'S DEPARTMENT TO STATE ONLY PREMISES. DO NOT LEAVE OFF THIS STATION UNLESS THEY ARE CALLED TO GO STRAIGHT BACK TO THE STATION. DON'T GIVE THEM THE RIGHTS TO ROAM THE STREETS. STOP INNOCENT MINORITY PEOPLE'S AND ALL COME UP AND KILL THE UNARMED PERSONS AND DON'T HAVE ANY TYPE OF ACCOUNTABILITY OF THEIR ACTIONS. WE SHOULD FREE POLITICAL RESPONSIBILITY. WE SHOULD CHANGE THE ECONOMIC ENTERPRISE BACK INTO FREE ENTERPRISE, CAPITALISM BACK INTO FREE ENTERPRISE. CAPITALISM MEANS CORRUPT GOVERNMENT. FREE ENTERPRISE MEANS CLEAN GOVERNMENT. FREE ENTERPRISE BEGAN IN THE SOUTH. AS MUCH IN THE FREE ENTERPRISE. CORRUPT GOVERNMENT ARE THE SOURCES OF THE CARPET BAGGER POLITICIANS SOUTH TO DESTROY THE SOUTH GOVERNMENT BECAUSE THE SOUTH HAD ALL THE WEALTH AND THEY TOOK THE MONEY OUT OF THE HAND OF THE INDIVIDUALS THAT WERE SHARING THE MONEY PROPERLY AND PUT IT IN THE HAND OF DESTRUCTION OF REPUBLICAN POLITICIANS AND THE BANKS AND EVERYTHING ELSE BEGINNING TO DECAY IN AMERICA. WE NEED HONEST GOVERNMENT, FAIR GOVERNMENT, WE NEED PEOPLE THAT CAN REPRESENT US MORE PROPERLY IN WHAT WE CALL THE UNITED STATES OF AMERICA. WE NEED MORE JOBS. WE FIND TODAY ECONOMIC RACISM WAS IN RACE. LOS ANGELES, CALIFORNIA, YOU NOT GOING TO GET NO JOBS, NO AFRICAN-AMERICAN IS GOING TO GET NO JOBS UNLESS YOU CONNECTED WITH THAT CHURCH HOUSE. AND ALL THE PEOPLE AND GOVERNMENT IN LOS ANGELES CONNECTED WITH THE CHURCH HOUSE, PEOPLE ON THE OUTSIDE NOT GETTING CONNECTED BECAUSE THE PREACHERS AND THE POLITICIANS ARE VERY CLOSE TOGETHER. 

SUP. ANTONOVICH, MAYOR: THANK YOU. LET ME ALSO CALL UP ERIC PREVEN. YES, MA'AM. MISS SARNOFF. 

RUTH SARNOFF: RUTH SARNOFF. I WANTED TO KIND OF EXPRESS MY STRONG FEELINGS ABOUT NOT PLACING A JAIL OUT 90 MILES FROM LOS ANGELES. THE NEED TO HAVE PEOPLE CLOSE TO FAMILY IF THE PROGRAMS THAT WE'RE DESCRIBING ARE SUCCESSFUL AND WE PUT AS MUCH MONEY AND EFFORT INTO THE MAKING OF LOCAL MENTAL HEALTH SERVICES AND OTHER KINDS OF SERVICES FOR ADDICTION AND ANY OTHER KINDS OF PROBLEMS, IF WE MAKE THAT OUR FOCUS, AND IF WE START FUNDING IMMEDIATELY THE SERVICES END OF IT, I THINK WE'LL BE IN A STRONGER POSITION. THERE ARE FOUR EMPTY BUILDINGS THAT HAVE BEEN SITTING THERE FOR DECADES NOW IN DOWNTOWN LOS ANGELES. COURT BUILDING AND POLICE BUILDING. I DON'T KNOW. THERE'S A COUPLE MORE. THEY'RE ALL PLACES THAT COULD BE RENOVATED FOR PROVIDING CENTRALIZED SERVICES THAT COULD HELP -- THAT PEOPLE COULD EASILY GET TO FROM THE EAST HOLLYWOOD, FROM MCARTHUR PARK, FROM PLACES IN HIGHLAND PARK, EAST L.A., ALL OVER BECAUSE IT'S THE HUB. AND I THINK SOME THOUGHT SHOULD BE GIVEN TO TRANSFORMING, MAYBE PUT AN ATRIUM IN THE TOP AND PUT LOTS OF PLANTS INSIDE OF THOSE BUILDINGS AND CREATE SOME LIGHT IN PLACES WHERE FAMILIES AND CLIENTS COULD BEGIN TO COME TOGETHER. DO SOMETHING CREATIVE. 

SUP. ANTONOVICH, MAYOR: THANK YOU. MR. LUCAS AND ALSO MR. SACHS. 

ROBERT LUCAS: GOOD AFTERNOON. ONCE AGAIN ABOUT THE ADJOURNMENTS, I CAN'T TELL YOU HOW MANY TIMES GROWING UP, "1 ADAM 12, 1 ADAM 12, SEE THE MAN." AND DEAN JONES. DEAN JONES, I ENVIED HIM BECAUSE HE WAS CONSTANTLY CHASING AFTER MICHELLE LEE. AND I WAS A KID. AND I DID ENJOY THE CAR. BUT, YEAH, THAT WAS THE FOND MEMORIES IN A LOT OF MY CHILDHOOD SPENT WITH THOSE TWO INDIVIDUALS. THIS WEEKEND I GOT TO SPEND THREE DAYS IN A NATIVE AMERICAN RITUAL. AND IT'S ALSO KIND OF DEEMED AS A DISSIPATION. AND SOME OF THE PEOPLE THAT WE INVITED TO THIS DISSIPATION, IT WAS THREE DAY OF WALKING THROUGH A JOURNEY AND A PATH OF YOUR LIFE. AND WITH SOME OF THE STRENGTHS THAT WERE INVOLVED IN THIS, IT WAS TRULY AN EMOTIONAL CLEANSING. AND I FOUND MYSELF COMING OUT OF IT STILL AS AVIDLY PASSIONATE TOWARDS SOME OF THE WORK THAT ALL OF THE SUPERVISORS HAVE STARTED BECAUSE IT WAS REALLY AFFIRMED IN SOME OF THESE INDIVIDUALS' STORIES THAT THERE'S MORE THINGS THAT WE HAVE IN COMMON THAN WE HAVE DIFFERENCES. AND IT SEEMS A LOT OF THE SOCIAL ANXIETY AND THINGS IN MY OPINION WE FOCUS ON THE DIFFERENCES WHICH ARE FAR LESS THAN THINGS WE HAVE IN COMMON. AND IT TOOK ME A WHILE TO REALIZE THIS. I JUST KNOW THAT WHEN I COME INTO THIS CHAMBER AND SOME OF THE WORK THAT'S DONE, LIKE I MENTIONED LAST WEEK, IT'S VERY GRATIFYING BECAUSE IT'S HEADED IN THE RIGHT DIRECTION. 

SUP. ANTONOVICH, MAYOR: THANK YOU, MR. LUCAS. YES, MA'AM. 

CHIKODILI UDENGWU: THANK YOU. GOOD AFTERNOON, HONORABLE BOARD OF SUPERVISORS. MY NAME IS CHIKODILI UDENGWU, I WAS HERE ON FEBRUARY 4TH, 2015 AND REGARDING SOME ISSUES REGARDING MY SALARY AND MY RETIREMENT BENEFIT AND MY ACCRUED TIME. I STARTED WORKING FOR THE COUNTY IN 1999 AND THROUGHOUT MY SERVICE, I HAVE SERVED SELFLESSLY AND THE RECORD SPEAKS FOR ITSELF. SO IN SEPTEMBER 2014 AND BEYOND THAT, I STARTED COMPLAINING IN 2010 ABOUT MY SALARY, WHICH LED ME TO SOME ALLEGATION THAT LED TO SUSPENSION, SO WHILE I WAS INVESTIGATING I DISCOVERED THAT MY SALARY WASN'T WHAT I WAS SUPPOSED TO BE GETTING. I WAS GETTING $3,000 LESS THAN MY COUNTERPARTS. AND MY RETIREMENT HAS NOT BEEN PAID. AND WHEN I CAME IN HERE, THEY TOLD ME SOMEBODY WILL CONTACT ME FROM THE DIRECTOR OF HEALTH SERVICES, WHICH IS MR. KATZ. AND WHEN I CALLED, THEY SAID THEY DON'T KNOW ME. SO I'M HERE AGAIN PLEADING FOR THE SUPERVISORS TO PLEASE INVESTIGATE IT AND RATIFY MY SALARY. BECAUSE FOR FOUR YEARS OR MORE I'VE BEEN STRUGGLING. HARD WORK NEEDS TO BE PAID OFF. AND COMING HERE IS ALMOST LIKE THE LAST RESORT. AND I'M PLEADING THAT SOMETHING BE DONE ABOUT IT. ANYBODY CAN ASK ME QUESTIONS REGARDING THE LETTER. THANK YOU. 

SUP. ANTONOVICH, MAYOR: LET ME HAVE SOMEBODY FROM H.R. COME DOWN AND TALK TO YOU ON THIS. SO JUST WAIT. WE'LL HAVE SOMEBODY COME DOWN AND TALK TO YOU ON THIS. 

CHIKODILI UDENGWU: THEY DID THAT. I JUST WANTED SOMEBODY THAT I CAN GO TO FOR THIS THING TODAY SO THEY DON'T HAVE TO WHEN I CALL. 

SUP. ANTONOVICH, MAYOR: WE WILL HAVE SOMEBODY COME DOWN AND TALK TO YOU NOW. 

CHIKODILI UDENGWU: VERY WELL, THANK YOU. 

SUP. ANTONOVICH, MAYOR: MR. PREVEN. 

ERIC PREVEN: JUST TO BE CLEAR, SIR, THEY ARE COMING DOWN THE STAIRS FROM UPSTAIRS. IT IS ERIC PREVEN FROM COUNCIL DISTRICT THREE. 

SUP. ANTONOVICH, MAYOR: FROM THE NEXT ROOM. 

ERIC PREVEN: COUNTY RESIDENT FROM DISTRICT 3, IN FACT. I WANTED TO CIRCLE BACK QUICKLY COUPLE ITEMS THAT WERE CONTINUED ITEM 9 AND 10. 9 SUPERVISOR KNABE BOLDLY REQUESTED THE DIVERSION AND RE-ENTRY PIECE BE CONSIDERED IN THE APRIL BUDGET. BUT OBVIOUSLY I THINK WE ALL AGREE THAT WE SHOULD BE DEALING WITH THAT EVEN SOONER THAN NEXT APRIL. SO I THINK THAT WILL PROBABLY COME OUT WHEN IT COMES BACK. AND THEN ITEM NO. 10 IS IF I'M NOT MISTAKEN HIS CONCERN ABOUT HOW WEE USE OUR SUPPLEMENTAL AGENDA, WHICH I'M SURE HE WAS VERY EXERCISED ABOUT RECENTLY. I'M SURE HE WAS LESS EXERCISED WHEN HE PUT 63-E ON THE SUPPLEMENTAL AGENDA IN DECEMBER OF 2013 WHICH WAS THE TRANSFER OF ALL THE GOLF COURSES. REGARDLESS THOUGH IT SHOULD NOT BE USED TO FAKE OUT THE PUBLIC OR OTHER SUPERVISORS. I ADMIRE WHAT HE'S DOING THERE AND I DO APPRECIATE THAT. SIR, OVER THE CITY HALL THEY ARE DESPERATELY CHASING YOU IN THE OPEN GOVERNMENT COMPETITION. THEY ARE NOT DOING WELL. YOU ARE LAPPING THEM REPEATEDLY, BUT SIR, THEY HAVE AN ITEM ON THEIR AGENDA ITEM TODAY, ITEM 12 WHICH WAS ABOUT BELIEVE IT OR NOT ABOUT THE AVAILABILITY OF FUNDS FOR ADDITIONAL MENTAL HEALTH TRAINING FOR L.A.P.D. WHAT THEY CAME UP WITH WAS NOTHING, SADLY. THEY DID NOT FIND ANYTHING IN THE KITTY. MR. KREKORIAN LOOKED BUT COULDN'T FIND ANYTHING. THEY LOOKED TO GET SOME FUNDING FROM THE STATE OR SOMEONE ELSE. NO SUCH LUCK. THE GOOD NEWS IS THEY FOUND A FOUNDATION GRANT FOR SOME POST FUNDING TO DO 30-HOUR OR 30-SOMETHING HOUR COURSE, NO. IT'S A COURSE THAT TAKES TIME. THEY DO IT ONCE A MONTH. THERE ARE 30 PEOPLE THEY HAVE TRAINED. SINCE 2014 PUNCH LINE THEY GOT 200 AND SOMETHING PEOPLE TRAINED. THIS IS THE GROUP THAT HAS 80 POLICE OFFICERS WHO TRAVEL WITH MENTAL HEALTH TOGETHER, WHICH IS DOING A LOT BETTER THAN WE ARE, BUT WE HAVE BEEN AUGMENTING THAT. I NOTICE IN ONE OF THE ITEMS TODAY WE HAVE SOMETHING LIKE 20 OPERATIVE NOW IN THAT PAIRING. SO IS THERE SOME WAY WE CAN ALSO RAISE MONEY PRIVATELY IN ORDER TO GET MENTAL HEALTH TRAINING? OR IS THERE SOME WAY THAT WE, SINCE WE'RE SPENDING SO MUCH MONEY WITH ALL THESE ADDITIONAL ITEMS AND SUCH, TRAINING, CAN WEE TRAIN THE L.A.P.D. GUYS, TOO? CAN'T YOU TEAM UP TO GET MENTAL HEALTH TRAINING? 

SUP. ANTONOVICH, MAYOR: THANK YOU. MR. SACHS. 

ARNOLD SACHS: YES, THANK YOU. AND THANK YOU, MR. PREVEN, BECAUSE IT REMINDED ME THERE WAS ANOTHER ITEM ON THE CITY COUNCIL AGENDA TODAY AND IT REFERENCED THAT THE CITY ATTORNEY WOULD LOOK INTO THE LEGALITY AND CONTENT OF A PARTICULAR CITY ORDINANCE. LEGALITY AND CONTENT. ALL WHAT YOU DO WHEN YOU HAVE YOUR ITEMS ON THE AGENDA THAT THE CITY ATTORNEY HAS REVIEWED, THEY'VE REVIEWED FOR CONTENT. IMAGINE THAT CONCEPT OF LEGALITY. BLOWS THE MIND. AND IN TODAY'S L.A. TIMES, "CONFLICTED ON CLIMATE CHANGE LAW." THAT IS WHAT YOU DISCUSSED LAST WEEK. IT WAS ACTUALLY SUPPOSED TO BE ON THE AGENDA THIS WEEK BECAUSE THAT'S WHAT THE COUNTY COUNSEL HAD MENTIONED. YOU WOULD PUT IT ON THE AGENDA. BUT THEN AGAIN, MS. SOLIS WANTED TO HAVE IT AS AN EMERGENCY HEARING LAST WEEK BECAUSE IT WAS AFRAID YOU WERE GOING TO VOTE ON IT. OR WAS GOING TO BE VOTED ON BY THE STATE LEGISLATURE. SO SHE PUT A MOTION IN FOR RECONSIDERATION AND YOU VOTED ON IT 3-2 TO RECONSIDER IT. BUT YOU DIDN'T HAVE ANOTHER VOTE FOR EMERGENCY STATUS. AND YOU DIDN'T HAVE ANOTHER VOTE AFTER THE EMERGENCY STATUS ON VOTING ON THE ITEM. SO YOU TOOK ONE VOTE. IMAGINE THAT. WHERE WAS THE COUNTY COUNSEL ON THAT? WELL, I DON'T KNOW. MAYBE ASLEEP. THERE WAS A PICTURE IN THE NEWSPAPER OF SOMEBODY DRYING ONE OF YOUR AUTOMOBILES WHEN YOU WERE DEALING WITH THE CAR WASHING FIASCO. SO WITH THE COMBINATION OF ALL THE DEPARTMENTS, MAYBE YOU CAN COMBINE HIS JOB WITH COUNTY COUNSEL. YOU'LL GET SOME CONTENT. YOU'LL GET A CLEAN CAR. AND WE WON'T GET ANY ANSWERS. IT MIGHT WORK. WHY NOT? I MEAN, YOU TALK ABOUT THE FAIRNESS AND THE LAWS AND EVERYTHING THAT WE'RE DOING TO BE OPEN AND TRANSPARENT AND THEN -- 

SUP. ANTONOVICH, MAYOR: THANK YOU. ANY ITEMS? MOTION TO ADJOURN? WITHOUT OBJECTION. [GAVEL] SO ORDERED. 
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